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Preface

Before you begin

Please read this operation manual before attempting to
use the P350 flexitrax system. Note that this manual and
all its contents are subject to change. Pearpoint products
are under continuous development.

Pearpoint reserves the right to modify any product, including
this manual, without notice and some product changes may
have taken place after this user manual was published.

Contact your local Pearpoint dealer or visit

www.radiodetection.com for the latest information
about the P350 flexitrax product family, including all
accessories, documentation and software updates.

Important safety notices

Please observe all safety notices and warnings in this manual
before operating any Radiodetection or Pearpoint product.

Warnings, Cautions and Notes

WARNING!: Warnings alert you to possible personal
injury.

NOTE: Notes contain useful information.

Key to symbols used

A General Warning: Refer to Manual for specific
instruction or advice.

& Electrical Hazard: Observe safe practices and
exercise extreme caution.

& Heavy object: Additional care must be taken when lifting.

Biohazard: Disinfect after use. Wear appropriate
personal protective equipment (PPE).

Hot Surface: Allow to cool or use appropriate
protection when handling.

Pinch point: Keep fingers or loose clothing clear.

General

Pearpoint has taken care to provide the necessary
information in this manual for the safe installation,
operation, maintenance and disposal of this equipment.
However, a risk assessment should be performed prior
to commencing work as it may highlight additional safety
issues specific to the application.

Installation

The P350 flexitrax, including its component parts is heavy.
If available, use the wheels to assist transport. Observe
heavy-lifting safety practices when lifting any component
of this system. Refer to the specifications in Appendix 9.9
for a description of the system’s dimensions and weights.

If mains operated equipment is connected to the

system then the external equipment must be earthed in
accordance with the manufacturer’s instructions. Failure
to comply with this may cause the unit to become live and
a LETHAL HAZARD.

Generator Selection

Pearpoint strongly recommmends the use of generator
equipment with Inverter type outputs. This results in the
best possible quality of supply voltage to the P350 system
over varying load conditions. To power the P350 system
in isolation (in all configurations) requires an inverter output
rated at 1.2kVA, additional electrical loads connected to
the same generator will increase the overall required rating
accordingly.

Generator equipment with AVR type outputs may be
suitable for use if the minimum requirements of generator
loading for AVR operation are met under all operational
circumstances; this is one reason why inverter output
equipment is highly recommended. The minimum load
the P350 system provides can be as low as 75VA. AVR
equipment operated below its minimum loading can lead
to loss of voltage regulation that could cause damage to
the P350 system. Additional high power loads (such as a
water heater or air-conditioner) on an AVR generator can
also lead to voltage fluctuations that could exceed the
maximum ratings of the P350 system.

Generator equipment that does not employ voltage
regulation techniques outlined above (e.g. condenser
output or synchro-converter output) must not be used with
the P350 system as damage to the P350 system from
unregulated voltages is likely.

If in doubt regarding generator output selection, voltage
stability or installation of the generator into a vehicle, consult
a qualified electrician and/or your generator supplier.
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Operation guidelines

Please observe your company, region or country’s
Standard Code of Practice for surveying underground
utilities with CCTV equipment, if applicable, when using
this equipment.

Always carry out a risk assessment of the site to be
inspected. This equipment is NOT approved for use in
areas where hazardous gasses may be present.

Foul water systems can be a source of serious
biological hazards. Wear appropriate protection when
handling the P350 flexitrax.

The camera will get hot during use. This is normal.
Exercise care when handling the camera at all times.

& System components must NOT be connected/
disconnected when the power is on.

Take care to ensure that video and power cables do not
get entangled in the drum. Cables ties are recommended
and will not impede system performance.

Always store the P350 flexitrax system in a clean and dry
environment.

Safety precautions

Ensure that standard safety precautions for working in
hostile environments are followed.

The flexitrax Power Supply Unit (PSU) is designed to
reduce hazards from electric shock provided that proper
operating procedures are followed. The P350 flexitrax
system requires connection to a protective earth; if in
doubt, consult a qualified electrician.

Electrical equipment is factory tested for electrical safety.
Routine inspection is recommended (and may be required
by law) to maintain this level of protection. If you are
unsure, contact your local safety authority for advice.

The flexitrax Power Supply Unit has a number of
ventilation slots around the casing that are designed

to maximize air circulation and reduce heat. There is a
potential fire risk if the build-up of heat is prevented from
escaping. Under no circumstances are these ventilation
slots to be covered or blocked.

If using a generator follow the manufacturer’s instructions
on load connection and sequencing. In the absence of
these instructions the following guidelines should be used:

¢ When starting the generator; ensure that all electrical
loads, including the P350 are switched off before
starting the generator. Allow the generator to
stabilise before connecting any electrical loads or
switching on the P350.
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¢ When stopping the generator; ensure all electrical
loads, including the P350 are switched off before
stopping the generator.

¢ Starting or stopping a generator whilst the P350
system is connected and the main switch is in the
On position could lead to damage to the P350
system or the generator.

Always use heavy duty industrial gloves when handling
cable which is being withdrawn from a sewer.

Always ensure that cabling is properly connected.

A portable generator can be a hazard if not properly
operated. Always follow the manufacturer’s instructions.

Always transport a generator with the minimum amount of
fuel in the tank.

Always switch the system on and off using the main
system switch.

Never lower crawlers or other heavy equipment into
manholes while personnel are working in the manhole.

To avoid risk of burns do not touch cameras/
lightheads when they are switched on or immediately
after switch off. Leave ample time for them to cool before
handling.

A The camera’s LEDs are very powerful. Do not look
directly at the LEDs or point them at other people.

Maintenance

Clean and sanitize the P350 flexitrax system at regular
intervals and after conducting an inspection.

Always keep all connectors covered with their protective
caps when the equipment is not in use.

Do not dismantle any component of this system
unless directed by this operation manual. Dismantling
components not specified by this manual may void the
product warranty.

Pearpoint recommends that only authorized service
centers carry out service of this product. Service
elsewhere will void the warranty.

For information regarding any service needs, please
visit www.radiodetection.com or contact your local
Radiodetection or Pearpoint representative or dealer.

Disposal

Do not dispose of this product in municipal waste
facilities. Please check local regulations for disposal of
electronic products.

Radiodetection complies with the requirements of
2002/96/EC Waste Electrical and Electronic Equipment.



Declaration of Conformity

We: Radiodetection Limited

Western Drive
Bristol
BS14 0AF

Declare that the products listed below satisfy the essential requirements of the following Council Direclives:
= 2004/108/EC, relating to Electromagnetic Compatibility. (EMC)

+  2006/95/EC, relaling to Electrical Equipment within certain voltage limits (LVD)

« 1999/5EC, Radio & Telecommunications Terminal Equipment Directive (R&TTE)

P350 “flexitrax” inspection system
Comprising modules from the following list and ancillary equipment listed in the technical file.

Componant Part Number Description 1

Command module | 10/P350-CMOD | P350 Command Module |

Drums 1P350-DRUM-P- xxx P350 Powered Drum, 100m, 150m, 250m 1
10/P350-DRUM-M-xxx P350 Manual Drum, 100m, 150m, 250m

P3SU 10/P350-PSU-M P350 PSU for Manual Drum

Crawlers 10/P354 P350 100mm (4") Crawler

| 10/P3s6 P350 150mm (6") Crawler

Cameras 10/P350-CAM-FW- yyyy | P350 PAL/NTSC Forward View Camera
10/P350-CAM-PT- yyyy | P350 PALUNTSC Pan & Tilt Camera
10/P350-CAM-PTZ-yyyy | P350 PAL/NTSC Pan & Tit, Zoom Camera

The following standards have been used in the evaluation

EMN 61010-1: 2001 Safety requirements for electrical equipment for measurement
control and laboraiory use.
EMB1326-2-1: 2006 Eleclrical equipment for measurement, control and laboratory use.
EMC Requirements,
EM 301 489-17: 2000 ElectroMagnetic Compalibility and Radio Spectrum Maiters {ERM);

ETSI TR 102 070-1 Scenario 2 has been applied for integration of a type approved Bluetooth module

The Technical Construction File has been drawn up to demonstrate compliance with the essential
requirements of these Direclives and is kept at the above address

Date: 04/12/2008

signed ). A5, /IF‘COV\_ el

Director

Radiodatection Lid

Western Drive

Bristol BS14 0AF, UK

Tel: +44 (00 117 976 7776

Famx: +44 (0) 117 976 7775
amail:sales.uki@radiodalection. spx.com
hitp:ivwww.radiodetection.com

L
'i"“‘ﬂ Radiodetection

Certificate Mo, TD-2008-001-01
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Compliance

EU Compliance
This equipment complies with the following EU Directives.
¢ Low Voltage Directive: 2006/95/EC
e Machinery Directive: 98/37/EC
e EMC Directive: 2004/108/EC
e R&TTE Directive: 99/5/EC

FCC Compliance Statement

This equipment complies with Part 15 of the FCC Rules.
Operation is subject to the following two conditions:

® The equipment may not cause harmful interference.

¢ The equipment must accept any interference
received, including interference that may cause
undesired operation.

Note: This equipment has been tested and found

to comply with the limits for a Class A digital device
pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against
harmful interference when the equipment is operated in
a commercial environment. This equipment generates,
uses, and can radiate radio frequency energy and,

if not installed and used in accordance with the
manufacturer’s instruction manual, may cause harmful
interference with radio communications. Operation of
this equipment in a residential area is likely to cause
harmful interference, in which case you will be required
to correct the interference at your own expense.

Modifications: Any modifications made to this equipment
that are not approved by Pearpoint may void the authority

granted to the user by the FCC to operate this equipment.

Industry Canada compliance
statements

ICES-003 Class A Notice:

This Class A digital apparatus complies with Canadian
ICES-008.

Avis NMB-003, Classe A:

Cet appareil numérique de la classe A est conforme a la
norme NMB-003 du Canada.

Bluetooth transmitter

Contains Transmitter Module FCC ID: PI1409B / IC:
1931B-BISMPASS.
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Trademarks

flexitrax, flexiprobe, FlexiSight and RD7000DL are
trademarks of Radiodetection Ltd, all rights reserved.

Pearpoint is a trademark owned by Radiodetection Ltd
- SPX Corporation.

The Bluetooth word, mark and logo are registered
trademarks of Bluetooth SIG, Inc. and any use of such
trademarks by Radiodetection is under license.

Windows, Windows XP, Windows Vista, Windows
Media Player, Windows Movie Maker, Microsoft Word
and Microsoft Office 97 are trademarks of Microsoft
Corporation, all rights reserved.

QuickTime, Mac, Mac OS, Finder, iMovie and Final Cut
Pro are trademarks of Apple Inc., registered in the U.S
and other countries.

Other trademarks or registered trademarks mentioned in
this document belong to their respective owners.

Disclaimer

Any third-party products (including hardware, software
and services) mentioned in this manual are for
instructional purposes only and is not an endorsement by
Radiodetection Ltd, Pearpoint and SPX Corporation.

Radiodetection Ltd does not accept any liability for loss of
data or damage to equipment when using any third-party
products.

Copyright statement

Copyright 2011 Pearpoint Ltd. / Radiodetection Ltd
— SPX Corporation. All rights reserved.

Radiodetection is a subsidiary of SPX Corporation.

SPX, Radiodetection and flexitrax are trademarks of
Radiodetection Ltd. and SPX Corporation. Due to a policy
of continued development, we reserve the right to alter or
amend any published specification without notice.

This document may not be copied, reproduced,
transmitted, modified or used, in whole or in part, without
the prior written consent of Radiodetection Ltd.

Training

Pearpoint provides training services for most Pearpoint
products. Our qualified instructors will train equipment
operators or other personnel at your preferred location
or at Pearpoint headquarters.

For more information go to www.radiodetection.com
or contact your local Pearpoint representative.
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Section 1 - Introduction

1.1 About this manual

This manual provides comprehensive operating
instructions for the P350 flexitrax™ pipeline video
inspection system. Before attempting to operate the
P350 flexitrax system it is very important that you read
this manual, noting all safety warnings and procedures
in the Preface, Section 1.3 and throughout the rest of
the manual.

Once you have read this manual, it is recommended that
you retain it for reference purposes. A printed version of
this manual is available on request. Please contact your
local Pearpoint representative for more information. The
rest of the manual is detailed as follows.

Section 2 includes annotated illustrations of the command
module, powered and manual drums and selected
accessories.

Section 3 provides a detailed guide to assembling the
system ready for conducting inspections.

Section 4 provides a comprehensive introduction to using
and configuring the command module.

Section 5 introduces the basics of pipeline inspections
and describes how to deploy and drive the crawler,
create video recordings and control the camera during

an inspection. Section 5 also details retrieving the crawler
safely once the inspection is concluded.

Section 6 introduces the Compact Flash card browser and
provides a detailed guide to managing your survey files.

Section 7 introduces the report writing function and
shows you how to view reports or convert them to
Microsoft Word format. Section 7 also details the ability to
edit and display system text pages.

Section 8 provides a comprehensive guide to digital video
options and settings. Section 8 also includes a guide

to converting and distributing videos for playback on
computers and other video equipment.

Section 9 is an appendix that includes reference and
other important information as well as instructions on
caring for and maintaining your P350 system.

1.2 Overview

The P350 flexitrax is an advanced pipeline video
inspection system that is ideal for a broad range of
applications. This system allows operators to identify and
document pipeline faults using the latest in digital video
recording technology.

The P350 flexitrax is a fully modular system; the
command module can drive any combination of drums,
cameras and crawlers and is also compatible with the
P330+ and P340 flexiprobe™ range of pushrod reels and
cameras.

1.3 Safety notices

Caution must be taken when conducting any pipeline
or draining system inspection. Please observe all safety
warnings located in the Preface and throughout this
operation manual.

Before you attempt to operate the P350 flexitrax
system, it is recommended that you familiarize yourself
with any additional health and safety requirements that
may be defined by company policy and any applicable
local or national laws. Contact your company’s or

local government’s health and safety officer for further
information.

1.4 Latest updates and information

Pearpoint may have released new system software, user
documentation or other information after you purchased
your system.

You can download the latest software, documentation
and application notes from www.radiodetection.com.

For more information about checking and upgrading your
system’s software, please refer to Appendix 9.3.

P350 flexitrax Operation Manual 1



Section 2 - System

2.1 Command module

The command module acts as the controller and digital
video recorder and playback device. Video is displayed
on an 8” industrial LCD. Video, pictures and inspection
reports are stored on a compatible high-speed Compact
Flash card.

1.

10.

11.
12.

13.
14.

On/Off Switch: This switch only works when the
unit is powered by a DC source connected to the
power socket.

Keypad and function keys: Allows the operator to
control the system, select functions and edit text
entries.

Keyboard: Provides enhanced text entry
capabilities and shortcuts to access system
functions.

Display: LCD Screen shows video, images and
various on-screen system information.

Link Cable Socket: To connect the pushrod reel,
powered drum or manual external PSU to the
command module with a link cable.

Command module support clamp: To mount the
command module to the powered or manual
drum support stand or to the optional vehicle wall
mounting kit.

Fuse holder: 5x20mm T3.15A 250V cartridge
fuse.

RCA Video Jacks: Provide secondary input and
output options for external composite video
equipment.

Power Socket: DC power input from vehicle
supply, battery box or mains adapter. For use with
pushrod reels or as a standalone unit.

Compact Flash card slot: The command module
uses a Compact Flash card to store video
recordings, reports and pictures. Most stored
files can be viewed or played on the command
module or transferred to PC. Also used to store
and upload software upgrades.

Keyboard Socket: Connects the keyboard.

Audio Socket: Connects the optional headset to
record audio over videos.

USB-A socket: Reserved for future use.

USB-B socket. USB connection to transfer files to
computers.
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15.

16.

overview

RJ-45 socket: Connects to a PC running
compatible reporting software.

Optional Vehicle wall mount kit: to mount the
command module to the side of your van
(not shown).

2.1.1 Keypad

17.

18.
19.

20.

21.

22.
23.
24.
25.

26.

27.

28.

290.

30.

Function keys: Use to select menu items or
activate shortcuts.

Camera key: Press to take screen captures.

Text key: Press to access the Text and Report
menu.

Play: Enters the card browser menu. Starts video
playback of selected file.

Pause: Press to pause video playback or
recording.

Record: Press to begin a new video recording.
Stop: Press to stop video playback or recording.
Crawler stop: Stops the crawler moving.

Arrow keys: Use for navigation and to select
system parameters.

OK: Press to select or confirm choices in the
menu system.

LED Brightness/Camera Focus keys: Adjust LED
brightness and camera focus. Fn + brightness key
to adjust camera focus.

Rotate/Pan keys: Press to rotate the camera view.
Fn + Rotate to pan left or right. Simultaneous
press will re-center the view.

Zoonm/Iris keys: Press to zoom in or out of the
camera’s subject. Fn + Zoom to modify the Iris.
Simultaneous press will reset the zoom to unity,
Fn + simultaneous press will reset to automatic
iris.

Function key (Fn): Press and hold to activate
different functions.



Figure 2.1: Command module Figure 2.3: Command module 1/0 panel
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2.2 Cable drums

The system supports either a powered or manual drum
that can accommodate cable lengths of 100m (330"),
150m (495’) or 250m (820’). The powered drum contains
an integral power supply whilst the manual drum requires
an external power supply unit.

The cable drum cassette in the powered drum is
user-replaceable. Please refer to Appendix 9.5 for
instructions on how to remove and install the cable
drum cassette.

Optional lengths of cable are also available for both the
powered and manual drums. Please refer to Appendix 9.5
for instructions on how to remove and install the cable.

Please visit www.radiodetection.com for a complete list
of spares and accessories.

2.2.1 Powered drum

1. Command module support stand.

2. On/Off switch. Switches the system on or off.
3. Command module.
4

Reel compartment: Houses up to 250m (820°) of
cable wound onto the drum cassette.

5. Removable handle, handle bars and wheels:
Allow you to manoeuvre the system easily into
position.

6. Emergency stop: Instantly shuts off system
power. When initiated, the system must be reset.

7. Pendant connector: For connecting the optional
pendant controller.

8. Command module connector: To connect the
command module link cable.

9. BNC Video Jacks: Provide secondary input and
output options for external composite video
equipment.

10. Power supply socket: To connect mains power.
11. Fuse holder: 5x20mm T12A 250V cartridge fuse.

12. Crank handle: Will allow the manual retrieval of
the deployed cable. (Not shown).

13. Optional vehicle mounting rails: To secure the
system in your van. (Not shown).

14. Cable rollers.

4 P350 flexitrax Operation Manual

2.2.2 Manual drum
15. Cable drum: Houses up to 250m (820’) of cable.
16. Cable brake.
17. Crawler connection terminal (Not shown).
18. Crank handle socket.
19. Command module support clamp.
20. PSU link cable socket.

21. Manual layering handle: To assist with laying cable
evenly on the drum.

22. Cable rollers.

2.2.3 External PSU (manual system only)

2. On/Off switch. Switches the system on or off.

6. Emergency stop: Instantly shuts down the system
power. When initiated, the system must be reset.

7. Pendant connector: To connect the optional
pendant controller.

8. Command module connector: To connect the
command module link cable.

9. BNC Video Jacks: Provide secondary input and
output options for external composite video
equipment.

10. Power supply socket: To connect mains power.
11. Fuse holder: 5x20mm T12A 250V cartridge fuse.

23. Link cable connection for manual drum.

2.2.4 Link cables

24. Command module link cable.

25. Manual drum link cable.



Figure 2.5: Powered drum with command module installed
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2.3 Crawlers and Crawler cameras

The system offers two different crawlers: the P354
(100mm/4”) and P356 (150mm/6”). Both crawlers are
fully compatible with three interchangeable cameras.
The P350-CAM-FW is a fixed, forward view camera. The
P350-CAM-PT offers pan and tilt capabilities and the
P350-CAM-PTZ offers pan, tilt and 10x optical zoom.

2.4 Pushrod reels and cameras

The command module is compatible with the full range

of P330+ and P340 flexiprobe pushrod reels, cameras
and accessories. When used with a pushrod system,

the command module must be connected directly to

the pushrod coiler. Power is supplied by mains or a
vehicle adapter, which connects to the DC socket in the
command module’s I/O panel. When a pushrod system is
connected, the command module’s power switch will turn
the system on and off.

Refer to 4.8.1 for information on how to configure the
command module to drive a pushrod system

For information on assembling and using a pushrod
system, refer to the P330+ and P340 flexiprobe user
documentation available on the FlexiSight installation CD
or at www.radiodetection.com.

2.5 Accessories

The P350 flexitrax system features a range of accessories
that expand its functionality and range of applications.
Please visit www.radiodetection.com, for a complete list
of available accessories.

6 P350 flexitrax Operation Manual

Figure 2.10: P354 crawler with P350-CAM-FW camera installed




Section 3 - System assembly

The P350 flexitrax allows you to configure the

system in a large number of ways, depending on the
components you have chosen for your survey. This
section provides details on assembling and setting up
a system using either the powered or manual drum
and external PSU.

A WARNING! Before attempting to assemble the
system, ensure that the powered drum or the manual
PSU is switched off.

3.1 Crawler and accessories

You can configure the P354 and P356 crawlers with a
variety of wheels, tires, cameras and accessories to suit a
wide range of pipes and conduits.

Figure 3.1 demonstrates the modularity of the crawlers.
[t shows an exploded view of some of the many
configurations available.

Figure 3.1: P356 crawler assembly

3.1.1 Crawler weight (P354 Only)

The crawler weight is a metal plate designed to increase
traction on the P354 crawler by adding more weight to
the crawler’s body.

To fix this to the body, place the weight on the crawler’s
body before adding any other components or accessories
and fix in place using the supplied screws.
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3.1.2 Wheels and tires

The P354 is compatible with the 62mm (2.5”) and 110mm
(4.3”) wheel sets, which can be connected in singular

or twin configurations. This configuration allows you to
deploy the P354 in pipes from 110mm (4”) up to 380mm
(15”) in diameter.

The P356 is compatible with the 62mm (2.5”), 110mm
(4.3”) and 170mm (6.7”) wheels, which can be connected
in singular or tandem configurations. This configuration
allows you to deploy the P356 in pipes from 150mm (6”)
to 610mm (24”) in diameter.

The 62 and 110mm wheel sets are compatible with a
hard or soft tire set to suit most traction requirements.

Inner hub

Whesel or tire
Outer hub clamp
Fasteners
Washer

O~ wON =

Figure 3.2: Connecting various tires

Figure 3.3: Crawler configurations (opposite)
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For a complete list of compatible wheels and tires, please
visit www.radiodetection.com.

Figure 3.3 (opposite) shows a range of recommended
wheel and elevator configurations to suit a variety of
pipe diameters and to position the chosen camera in the
center of the pipe.

Figure 3.2 demonstrates how to attach wheels and tires
to the P354 and P356 crawlers (62mm and 110mm only).

The inner hub is located on the crawler’s body. Place the
wheel on the inner hub and secure in place using the
outer hub clamp.

NOTE: Make sure you affix the wheel screws firmly to
the crawler body.
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3.1.3 Cameras

The P354 and P356 are compatible with three high-
resolution cameras that support PAL or NTSC video
standards.

All cameras offer remote focus capabilities and use the
latest generation of ultra bright LEDs for optimum light
performance.

Cameras can be fitted direct to the crawler’s body or to
an elevator or lighthead if used. The cameras are simple
to attach as they can only be fitted in one way. A single
3mm Allen-head screw is used to secure the camera’s
collar to the crawler’s body, lighthead or elevator.

Figure 3.4 illustrates the connection of cameras using the
C-clamp connection. Note that the procedure is the same
for all supported cameras.

Figure 3.4: Connecting a fixed view camera

P350-CAM-FW (Figure 3.5): this robust and compact
camera offers a focal range from 10mm to infinity and a
120 Im light source.

Figure 3.5: Fixed view camera
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P350-CAM-PT (Figure 3.6): the pan and tilt capabilities
provides the crawler with almost 360° vision. The pan
and tilt camera’s focal range is from 10mm to infinity; it
features a 210 Im light source.

Figure 3.6: Pan and tilt camera

P350-CAM-PTZ (Figure 3.7): this camera has the same
pan and tilt features as the P350-CAM-PT camera. The
PTZ camera also features auto focus, 10x optical zoom
with a focal range of 10mm (WIDE) to infinity and a 420 Im
light source.

Figure 3.7: Pan, tilt and zoom camera

3.1.4 Elevator

The P350 elevators are used to elevate the camera and
help center it in pipes 254mm (10”) in diameter or larger,
see Figure 3.3. The elevator is installed between the
crawler and camera.

The P350 system offers a choice of 3 elevators:

e P350-ELV-F fixed elevator (Figure 3.8 left). The fixed
elevator will deploy the P354 in pipes up to 300mm
(12") and the P356 in pipes up to 380mm (15”).

e P350-ELV-A adjustable elevator (Figure 3.8 center).
The adjustable elevator will deploy the P354 in pipes
up to 350mm (15") and the P356 in pipes up to
458mm (18").



o P350-ELV-LAM large adjustable elevator (P356 only)  Figure 3.10: Installing the large adjustable elevator
(Figure 3.8 right). The large adjustable elevator will
deploy the P356 in pipes from up to 600mm (24").

Figure 3.8: P350 camera elevators

To adjust the P350-ELV-A elevator:

1. Loosen the Allen-head and the vent screws
(Figure 3.9)

2. Set the camera mount to the desired height.

3. Tighten the Allen-head and the vent screws to
secure the elevator.

Figure 3.9: Adjustable elevator

Vent screw

3.1.5 Auxiliary Lighthead

The lighthead accessory, see Figure 3.12, offers additional

LEDs to provide the camera with more light when

needed. With more light you can deploy the crawler in
Allen-head screw larger pipes or in pipes made from absorbent material that

would otherwise reduce visibility when inspected with the

standard camera LEDs.

The lighthead is fitted between the camera and the
crawler or between the camera and the elevator. The
lighthead provides up to an additional 850 Im.

Figure 3.12: Auxiliary lighthead

To fit the large adjustable elevator to the P356 crawler
align the four mounting holes and secure it using the four
screws provided. This is demonstrated in Figure 3.10.

To adjust the P350-ELV-LAM elevator twist the square-
recessed socket with the supplied chuck key to vary the
height as required. This is demonstrated in Figure 3.11.
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3.1.6 Crawler connection

Once you have fitted the crawler with the cameras,
wheels and other accessories, you can connect it to the
cable drum.

Connect the crawler cable termination to the terminal on
the back of the crawler’s body; use a 3mm Allen key to
tighten the cable termination’s C-clamp.

The cable connecting the crawler to the drum features a
strain relief assembly and a stainless steel spring guard.
The spring guard helps to protect the cable end against
damage to the cable sheath.

Figure 3.13 illustrates the strain relief clamp and spring
guard.

Refer to appendix 9.8, Step 9, instructions 9 to 14 for a
detailed guide on how to set up the strain relief and spring
guard assembly.

Ensure that there is sufficient slack on the cable when the
lanyards are taut.

Ensure the D-shackle retention pin’s heads are pointing
upwards.

A

Figure 3.13: Strain relief clamp and spring guard
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3.2 Crawler deployment tools

The crawler deployment grab tools for the P354 and
P356 crawlers are optional accessories that allow an
operator to safely deploy and retrieve a crawler into
manholes, culverts and other access points. The grab tool
can deploy and retrieve the crawler in conduits up to five
meters (16.5 feet)* deep. Using the crawler grab tool is
highly recommended.

*Using all four of the supplied guide rods. Maximum
deployment depth is limited to the length of the Bowden
cable.

A

Refer to Section 5.2 for a guide to crawler deployment
and Section 5.8 for a guide to crawler retrieval using the
deployment tools.

1 Cable termination C-clamp
2 D-Shackles

3 D-Shackle pin heads

4 Spring guard

5 Lanyards

12 P350 flexitrax Operation Manual
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3.3 Manual drum and external PSU

The manual drum (Figure 2.6) is a light-weight system
that can house up to 250m of cable. The external PSU
(Figure 2.8) connects to the manual drum using the link
cable (ltem 25 in Figure 2.9). The single end connects to
the manual drum and the split end terminals connect to
the manual drum connection panel on the rear side of the
PSU’s handle.

A

3.4 Powered drum

The powered drum (Figure 2.5) features a motorized cable
reel compartment that can store up to 250 meters of
cable. The cable is housed in a user-replaceable cassette.
For information on changing this cassette, please refer to
Appendix 9.5.

NOTE: The drum is capable of retrieving deployed
cable; however it is not designed to retrieve the crawler
without the crawler’s added assistance.

3.5 Command module

3.5.1 Mounting

You can mount the command module to the powered
drum using the support stand. The stand is fitted to the
drum chassis and the command module fits on top.
Once fitted to the drum, you can adjust the height of the
command module to suit your preference of working
environment.

If using a manual drum you can mount the command
module to the support stand, which is clamped to the
drum carrying handle.

3.5.2 Power, data and video

When using the manual or powered drum, a single link
cable (ltem 24 in Figure 2.9) supplies the command
module with power, data and video. The link cable socket
is located on the rear side of the command module (ltem
5in Figure 2.2).

Mount the command module and connect the controller
cable to the controller terminal on the powered drum or
external PSU (ltem 8 in Figure 2.7).

3.5.3 Compact Flash card

Insert a high quality Compact Flash card into the card
slot, which is located inside the Command Module’s I/O
panel (Item 10 in Figure 2.3).

Please note the orientation of the card before you attempt
to insert it into the command module. Although a groove
on the card will prevent you from inserting the card the
wrong way this can be forced, which will damage the
Compact Flash card receptacle.

For more information about Compact Flash cards,
including selecting high quality cards, refer to Section 6.

3.5.4 Keyboard

The supplied keyboard is connected via the PS/2
connector in the I/0 panel (Item 11 in Figure 2.3).

NOTE: Only the supplied keyboard is compatible with
the command module.

3.5.5 Headset

The optional headset allows you to record and hear
audio commentary in your video recordings. Connect the
headset to the audio socket in the I/0 panel (Item 12 in
Figure 2.3).

3.6 External video equipment

You can connect a range of video equipment to the
system using the video jacks on the command module
(Item 8 in Figure 2.3), powered drum or the external PSU
(Item 9 in Figure 2.7). This can include video recording
and playback equipment or external monitors.

These devices are connected using standard composite
video cable with RCA or BNC-type connectors as
appropriate (not supplied).

A\ WARNING! Connected equipment must be
earthed according the equipment manufacturer’s
documentation. Failure to comply may result in
electric shock and damage to the flexitrax system.
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Section 4 - Command module and

system setup

This section introduces the P350 command module
and system setup.

4.1 Overview

The P350 command module acts as the main control
unit and digital video processor for the flexitrax system.
It is compatible with the powered drum, manual drum
and external PSU and the full range of P330+ and P340
flexiprobe pushrod reels and cameras.

The 8” LCD displays the on-screen system menu, the
camera’s video feed or the selected video and picture files
stored on the Compact Flash card. You can control the
command module using the keypad or the keyboard; this
manual will detail using both methods where applicable.

In addition to playback and control, the command module
can be connected to external video equipment with the
optional headset, to personal computers using the USB-B
or the RJ45 sockets and to compatible Bluetooth® devices.

4.2 Powering up

When the system is correctly assembled, switch it on using
the On/Off switch on the powered drum or external PSU.

NOTE: The command module takes approximately 10
seconds to display the first screen.

Depending on the settings, the command module will
display one or two splash screens followed by the
welcome screen (Section 4.4). The welcome screen
displays important system information; note it and press
OK to continue.

A

NOTE: When the command module is switched ON
with no camera connected, the screen will display a
vertical color bar chart.

NOTE: If the Emergency Stop button is used at any
time to shut down the system, the PSU must be reset
by rotating the Emergency Stop button with the main
switch set to OFF.
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4.3 Getting help

The command module has a built in, context sensitive
help screen. To access the help page, press Fn + F1
simultaneously on the keypad or Shift + F1 on the
keyboard.

You can also view a list of keypad and keyboard
shortcuts. Shortcuts allow direct access to main features
and help to make operation of the system more efficient.
To see a list of shortcuts press Fn + F2 simultaneously or
press Shift + F2 on the keyboard.

A list of shortcuts is included in Appendix 9.1.

4.4 Welcome screen

The welcome screen is the first screen to appear after the
Pearpoint logo and the optional splash screen. It provides
important information about the status and settings of
your system and should not be ignored. The welcome
screen is illustrated in Figure 4.1.

Figure 4.1: Welcome Screen
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The welcome screen includes the following information:

¢ \ideo mode (PAL or NTSC depending on camera).
e Compact Flash card size and free space.

¢ Reel or drum type (see Section 4.8).

e Crawler Type: P354 or P356.

¢ Wheel Size (see Section 4.9.1).

e Camera Type: FW, PT or PTZ.



e Company as defined in the Company Details menu
(see Section 4.10).

e Crew as defined in the Company Details menu
(See section 4.10).

To clear the welcome screen, press OK on the keypad.

NOTE : The P350 Command Module, Drum and
Crawler need to run compatible software versions,
otherwise the system may not work correctly. If the
software loaded on a component is incompatible with
the rest of the system, this is reported as a “mismatch”.
If a component does not have any software loaded as
a result of a failed software upgrade this is reported as
“no application”.

When a software "mismatch" or "no application" on

a component is reported, you need to complete a
software upgrade on that component to be able to use
the system (refer to Section 9.3.for a instructions on
how to obtain the latest software and how to perfrom a
software upgrade).

4.5 On-screen display (OSD)

The OSD provides real time system and telemetry
information overlaid on the video. The OSD also displays
the system menu when it is active.

OSD content will change depending the menu and mode
you are in as well as your personal settings.

The OSD displays the following information and graphics
(see Figure 4.2):

e Mode: currently selected driving mode (see Section
5.3). This is not recorded on video.

e Status: crawler and drum communication status
(see Section 5.3). This is not recorded on video.

e Time: system time (see Section 4.7).
e Date: system date (see Section 4.7).

e DVR: indicates recording (see section 5.4) and
playback (see Section 6.6) status. Also indicates
when a JPEG picture file is open (see Section 6.5).
This is not recorded on video.

e Distance counter: crawler position from 0.0 in feet
or meters (see Section 4.8).

e Page: the currently selected text page (see Section
7.3). This is not recorded on video.

e Numeric Inclinometer: displays the crawler’s
inclination in degrees or as a gradient percentage
(see Section 4.9.2). (Drive menu only).

e Mimic: provides crawler driving and steering (P356
only) speed. Also provides pan and tilt controls when
a pan and tilt camera is connected (see Section
5.3.3) (Drive menu only).

e System menu: main system menu (see Section 4.6).
This not recorded on video.

Figure 4.2 System onscreen display (0SD)
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4.5.1 Customizing the OSD

You can customize many features of the OSD to suit your
preferences. To modify the Drive OSD preferences refer to
Section 5.3.2.

To modify non-Drive specific OSD information, go to
SETUP -> OSD using the menu system (If you need help
navigating the menu, refer to Section 4.6).

From the OSD menu you can adjust OSD layout and the
appearance of text.

4.5.2 OSD layouts

The P350 System offers a choice of 3 different layouts
for the position of Date, Time, Counter and Pitch; these
layouts are: normal, TV and custom.

To choose a layout or to customize the position or visibility
of the OSD information fields go to the Layout menu by
pressing L'OUT.

Date, Time and Pitch can be individually hidden in all the
layouts.

1. Press P’SET to enter the OSD layout presets
menu.

2. Use the Up and Down keys to select your desired
layout.

3. Press OK to confirm your choice and return to the
Layout menu.
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This is the standard layout optimised to make use of
the entire screen (See Figure 4.3). OSD information
fields and overlaid text are positioned at the very edges
of the display.

Figure 4.3: Normal 0SD layout

This layout is optimised for a DVD Recorder/TV screen
(See Figure 4.4). OSD information fields and overlaid text
are positioned in the graphic safe area of the display.
Consult Section 8.7 for more details on producing TV
compatible recordings.

Figure 4.4: TV 0SD layout

This layout is customisable. The position of the 4 OSD
information fields can be moved anywhere on the screen
(See Figure 4.5).
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Figure 4.5: Custom 0SD layout
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A\ CAUTION: Be careful not to overlap the OSD
fields as this will affect their readability on the screen
and in recordings.

You can hide or move these OSD fields around the screen
(custom layout only):

1. Press TIME to enter the Time OSD menu or DATE
to enter the Date OSD menu.

2. Use the arrow keys to position the OSD field
(custom layout only).

3. Press RSTOR to restore the OSD field position to
the normal layout.

4. Press On/Off to toggle the OSD field visibility.

5. Press OK to confirm your choice and to exit the
menu.

In custom layout you can also move the counter OSD
field around the screen. You cannot hide this OSD.

1. Press COUNT to enter the counter OSD menu
(custom layout only).

2. Use the arrow keys to position the OSD field.

3. Press RSTOR to restore the OSD field position to
the normal layout.

4. Press OK to confirm your choice and to exit the
menu.

4.5.3 System menu timeout

You can choose whether to have the system menu
constantly visible on the screen or for it to disappear after
20 seconds.



1. Press MENU.
2. Use /\ or \/ keys to select the desired mode.

Menu timeout on:

If selected the system menu will disappear after
20 seconds. Press any function keys to make it
visible again.

Menu timeout off:

If selected the system menu will be constantly
visible on the screen. The system menu is not
recorded.

3. Press OK to confirm your choice and to exit the
menu.

4.5.4 Text appearance

You can customize the appearance of text on the OSD to
suit your preferences.

You can modify the text font color:
1. Press COLOR to enter the Color menu.
2. Usethe A or \/ keys to select your desired color.

3. Press OK to confirm your choice and to exit the
menu.

You can modify the transparency of the OSD field text
background:

1. Press TRANS to enter the Color menu.

2. Usethe A or V keys to select your desired
transparency level from black to transparent.

3. Press OK to confirm your choice and to exit the
menu.

You can modify the background color for system
information pages and the Report, Card and file browser
menus.

1. Press BACKG to enter the Background color menu.

2. Usethe /\ or \/ keys to select your desired
background color.

3. Press OK to confirm your choice and to exit the menu.

4.6 System Menu

The command module features an intuitive on-screen
menu that appears on the bottom of the OSD. This menu
provides users with access to all features and settings.
The menu is organized in hierarchical layers.

Figure 4.6: Main screen showing top-level system menu
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4.6.1 General navigation and text entry

Figure 4.6 illustrates the main page with the menu
highlighted in black at the bottom of the screen. The
figure shows the top-level menu. To navigate the menu,
use the function and arrow keys on the keypad or
keyboard. The <] key on the keypad will return you to the
previous screen; press this key several times and you will
return to the top-level menu. Once you reach the top-level
menu, pressing the < arrow will cause the menu to flash,
indicating that you cannot go higher.

If the menu disappears from the screen — when on-screen
timeout is enabled — then press any function key to return
to the last viewed menu option.

Where a selection is required use the A or V arrow keys
to cycle through the options in that menu screen. Use the
OK key (or Enter on the keyboard) to confirm the selected
choice.

NOTE: You can also use the keyboard’s Function, ESC,
Enter and cursor keys to navigate and select options in
the menu.

Where required you can enter text by using the keyboard
or keypad.

The keyboard is fully featured; you can enter any available
character and use navigation keys such as Home, End
and the arrow keys to position the cursor.

1. To delete all text to the left of the cursor, select DEL <.
2. To delete all text to the right of the cursor, select DEL >.
3. Press Esc to undo your changes and exit.
4

Press Enter to save your changes.
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You can enter text with the keypad arrows.

1. Use the A or V arrows to cycle through the list
of available characters.

2. Use the <] and [>> arrows to move the cursor

backwards and forwards along the line.

3. To toggle between upper and lower case press

CAPS.

4. To delete all text to left of the cursor, select DEL <.

5. To delete all text to the right of the cursor, select
DEL >.

6. Press CANCL to undo your changes and exit.

7. Press OK to save your changes.

Table 4.1: Setup menu schema

Menu
DEVCE
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CONTR

REEL

TRACT

CAM

TIME

DATE

KEYBD

LANG

UPDTE
- | MAIN
- | IFACE
- INFO

FONTS

METR

IMP

RSIZE

DRUM
- | ULOAD
- LOG
- INFO

ULOAD

LOG

INFO

W BAL
—| NEXT

4.6.2 SETUP menu

The SETUP menu provides access to all configuration
settings on the command module and most connected
components. Table 4.1 provides a comprehensive
description of the SETUP menu.

Description

Device menu.

Command module menu.

Set the time.

Set the date.

Select keyboard type.

Select system language.

Update command module software.
Update main controller software.

Update interface software.

Display command module software version.
Toggle between large and small fonts.
Drum and reel settings menu.

Select metric measurements.

Select imperial (US) measurements.

Select current drum / reel type and cable / rod size.
Drum and PSU menu.

Update powered drum and PSU software.

Creates a drum log file in the root directory of the CF
card (service use only).

Display Drum or PSU software version.
Crawler menu.
Upgrade crawler software.

Create a crawler log file in the root directory of the CF
card (service use only).

Display crawler software version.
Camera menu.
Adjust white balance.

Next setting.



OsD

COMMS

CMPNY

LouT

MENU

COLOR
TRANS
BACKG

BT

ETH

LOGO

PIPE
SURF
ULOAD
INFO

P’SET

TIME

DATE

COUNT

SCAN

KNOWN

SEL
SHOW

PREV
RESET

Normal
layout

TV layout

Custom
layout

RSTOR

OnOff

RSTOR

OnOff

RSTOR

PAIR
SEL
SCAN

DEL
SEL
SCAN

Previous setting.

Reset to automatic mode.

Optimize camera for pipe conditions.
Optimize camera for surface conditions.
Upgrade camera software.

Display camera software version.

On Screen Display menu.

On Screen Display Layout menu

Set OSD layout.

Layout optimised for digital recording.

Layout optimised for analogue TV.

Customisable layout.

OSD Time Menu.

Restore Time position to the default normal layout
position.

Display or hide the time.
OSD Date Menu.

Restore Date position to the default normal layout
position.

Display or hide the Date.
OSD Counter Menu.

Restore counter position to the default normal layout
position.

Enable or disable menu timeout.

Select font color.

Select OSD transparency level.

Select background color.

Communication menu.

Enter the Bluetooth menu

Search for nearby Bluetooth devices.

Pair with selected device.

Select discovered device.

Search for nearby devices.

Search for nearby Bluetooth paired devices.
Deleted selected paired device.

Select paired device.

Search for nearby devices.

Enter the ethernet menu.

Company details menu.

Select a company logo (32KB maximum).
Select logo picture from the root of the CF.

Show highlighted picture.
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- | REMOV Remove current logo.

- | COMPANY Company name.
- | CREW Crew name.
— | STREET Company address.
- | CITty City.
- | POSTCODE Post or Zip code.
- | PHONE Telephone number.
- | FAX Fax number.
- | EMAIL Email.
RSTOR Factory reset menu.
- YES Restore all settings to their factory defaults.
-/ NO Cancel system restore.

4.6.3 CARD menu

The card menu allows you configure Compact Flash card options; it also allows you to create, edit and delete
inspection reports. Table 4.2 provides a detailed overview of the card menu.

Table 4.2: GARD menu schema

Menu Description
DSTN Destination folder menu.
- NEW Create new directory.
- SET Set the selected directory as the default destination.
- | RENAM Rename the selected directory.
REPOR Inspection reports menu.
- NEW Create a new report.
- EDIT Edit an existing report.
- | DEL Delete a report.
CHECK Compact Flash card status.
FMT Format the Compact Flash card.
- YES Confirm format.
- NO Cancel format and return to the previous page.

4.6.4 DVR menu

The DVR menu allows you to adjust the command modules integrated digital video recorder settings.
Table 4.3 provides a detailed overview of the DVR menu.
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Table 4.3: DVR menu schema

Menu Description
INPUT Input source menu.
Auto Select the devices connected at startup giving
preference to a P350 camera.
External Select an external device.
Camera Select a P350 camera.
DESTN Destination folder menu.
NEW Create new directory.
SET Set the selected directory as the default destination.
RENAM Rename the selected directory.
FNAME Add a customized prefix to new recordings.
TITLE Video title menu.
Title on Enable video title screen.
Title off Disable video title screen.
REPOR Report popup menu.
Report Enable report popup menu.
popup on
Report Disable report popup menu.
popup off
QUAL Video quality menu.
HIGH High quality preset.
MED Medium quality preset.
LOW Low quality preset.
ADV Advanced quality settings.

SIZE Set video resolution (screen size).
FULL Select full video size (PAL or NTSE depending
on camera).
VGA 640 x 480 pixels.
QVGA 320 x 240 pixels.
BRATE Set bitrate.
HIGH Select highest bitrate.
MEDIUM Select medium bitrate.
LOW Select lowest bitrate.
ENC Set encoding quality.
Progressive | Encode video using full progressive scan.
Full
Progressive | Encode video using half progressive scan.
Half
Interlaced Encode video using interlacing.
FRATE Set video framerate (FPS)
Maximum Full NTSC (30FPS) or PAL (25FPS) framerate
depending on camera.
Medium Select medium framerate (20FPS).
Minimum Select lowest framerate (10FPS).
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4.6.5 SCRN menu

The SCRN menu allows you to set brightness and contrast of the command module’s LCD. Table 4.4 provides a
comprehensive description of the SCRN menu.

Table 4.4 Screen menu schema

Menu Description
BRI Set brightness level.
CONTR Set contrast level.

4.6.6 DRIVE

The DRIVE menu allows you to drive a crawler and set driving preferences.
Table 4.5 provides a comprehensive description of the DRIVE menu.

Table 4.5: Drive menu schema

Menu Description
SETUP Drive settings menu.
- | DRUM Drum menu.
-| METR Select metric units.
- IMP Select imperial (US) units.
—| ASTOP Set the Auto Stop point.
—| INFO Display Drum or PSU software version and Auto Stop
position.
- | TRACT Crawler menu.
- WHEEL Set the current wheel size.
—| None None selected.
- | 62mm Small wheel set.
-/ 110mm Medium wheel set.
—| 170mm Large pneumatic wheels (P356 only).
- | NPTCH Zero the numeric inclinometer.
- | PPROF Enable or disable the pitch profiler.
- | POWER Control the power to the tractor and camera.
- | INFO Display Crawler software version.
- | CAM Camera menu.
- WBAL Adjust white balance.
— | NEXT Next setting.
-| PREV Previous setting.
- | RESET Reset to automatic mode.
- PIPE Optimize camera for pipe conditions.
-| SURF Optimize camera for surface conditions.
- | ULOAD Upgrade camera software.
-| INFO Display camera software version.
— | SONDE Crawler sonde menu.
-| 512Hz Select 512Hz transmission frequency.
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RET

MAN /AUTO
EXIT

OsD

GO
CANCL

—| ©640Hz Select 640Hz transmission frequency.

- 8192Hz Select 8192Hz transmission frequency.
- | 32768Hz Select 32768Hz transmission frequency.
OSD menu.
MIMIC Mimic menu.
—| OnOff Hide or display mimic.
—| POSITION Set mimic’s position on screen.
—| COLOR Set mimic’s color.
NPTCH Numeric inclinometer menu.
—| RSTOR Restore numeric inclinometer position to the default

normal layout position.

—| OnOff Hide or display the inclinometer.

Enter automatic retrieval mode.

Start retrieval

Cancel retrieval.

Toggle between manual and automatic driving mode.

Exit the DRIVE menu.

4.6.7 TEXT and Report menu

The TEXT and Report menu allows you to create and edit reports and on-screen video text pages.
The text menu is accessed by pressing . Table 4.6 provides a comprehensive description of the TEXT menu.

Table 4.6: TEXT menu schema

Menu
EDIT

REPOR

HIDE
COLOR
TRANS

CAPS
DEL<
DEL >
CODES
CANCEL

NEW
EDIT
DEL

Description

Text menu.

Toggles lower and upper case.

Delete all characters left of the cursor.
Delete all characters right of the cursor.

Browse the Defect code file (if present).

Returns to the TEXT menu without saving the changes.

Displays the Report menu.

Create new report.

Edit existing report.

Delete report.

Hide the current onscreen text page (if any).
Chose font color.

Chose font transparency.
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4.7 Command module settings

Once the system is correctly assembled, you must
configure it for the first time before you begin your pipe
inspection. To set the command module’s basic settings
go to SETUP->DEVCE->CONTR and select from the
following options:

e TIME: enter the correct time and press OK to accept
or CANCL to cancel.

e DATE: enter the correct date and press OK to
accept or CANCL to cancel. Select D-M-Y or M-D-Y
to select your preferred date format.

e KEYBD: select the keyboard layout appropriate to
your language and/or region.

* | ANG: choose your preferred OSD language.
¢ FONTS: Toggle between large and small OSD fonts

NOTE: The system will store your preferences, cable
length and wheels and preserve them when it is
switched off.

4.8 Drum and reel settings

To access the drum and reel settings menu go to:
SETUP->DEVCE->REEL and select from the
following options.

¢ METR: Select metric units for the distance counter.
e |MP: Select imperial units for the distance counter.

e RSIZE: Select the correct drum or reel type and
length.

4.8.1 Drum type and cable length

Setting the correct cable length is critical for maintaining
communication between the command module and the
crawler and to ensure a constant video quality. You must
check this setting, and change it if required, every time
you replace or change the cable reel or switch between
pushrod and crawler-based configurations.

You can change the drum type and reel length using the
RSIZE option in the REEL menu as described above. You
can select the following options:

Reel: Cable 100m (330).
Reel: Cable 150m (500")
Reel: Cable 200m (660°).
Reel: Cable 250m (820).

00’
60’
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¢ Reel: Rod P341 Plumbers 30m (100°).
Rod P341 Plumbers 60m (100’).
Rod P341 35m (120°).

Rod P342 60m (200°).

Rod P342 120m (400).

Rod P343 150m (500).

* Reel:
* Reel:
* Reel:
* Reel:
* Reel:

NOTE: When selecting a Pushrod system the P350
Command Module will lock the DRIVE menu and
prevent its access. ROD will be displayed in the
OSD Status field.

4.9 Crawler and camera settings

4.9.1 Crawler wheel size

You must specify the size of the currently installed wheels
as the system uses this information to calculate the
crawler’s speed.

A

To set the wheel size, go to:
DRIVE->SETUP->TRACT->WHEEL using the menu system.
Use the /\ and \/ keys to select the correct wheel size:
e 62mm Small wheel set.
¢ 110mm Medium wheel set.
e 170mm Large Wheel set (P356 only).
Press OK to confirm your choice or <] to cancel.

4.9.2 Numeric inclinometer

The crawler features an integrated precision inclinometer
that provides a real time numeric reading of the crawler’s
body inclination.

The P350 inclinometer supports two units of
measurement: Degrees or Gradients. You should zero
the inclinometer when the crawler is leveled prior to
deployment.

To zero the inclinometer or setup the preferred units,
go to DRIVE->SETUP->TRACT->NPITCH using the
menu system.

* Press ZERO to zero the inclinometer.
¢ Press DEG to select Degrees.
¢ Press GRAD to select Gradients.

NOTE: The inclinometer is affected by a number of
factors including tire wear and tear and pressure
(pneumatic tires only).



4.9.3 Camera settings

The camera settings menu allows you to adjust the
camera’s white balance and operating mode. To change
camera settings go to DRIVE->SETUP->CAM and select
from the following options.

e W BAL: change the white balance or reset to factory
settings. Press NEXT or PREV to change the default
settings or RESET to go back to factory default.

e PIPE: optimize the camera for use in underground
pipes.

e SURF: optimize the camera for use on the surface.

4.10 Company details

The P350 flexitrax allows you to customize your system
by storing your company details and logo on the
command module. These details are used to personalize
reports and the video title screen.

NOTE: The video title screen is optional, for more
information please refer to Section 4.11.2.

Once you save your company’s information you will not
need to enter it again unless you perform a factory reset
(see Section 4.12).

Figure 4.7 Company information menu

pany Infor
{undefin

Email

1. Open the Company Information menu (SETUP ->
CMPNY). See Figure 4.7.

2. To edit a field, use the /\ and v arrows to select
the field you want to edit and then press OK.

Your company logo. To enter it copy a JPEG version of
your company logo (32KB maximum) into the root of a
compact flash card and insert it in the command module.

NOTE: The root directory refers to the top-level
directory of folder of the Compact Flash card. For more
information about the Compact Flash card, please refer
to Section 6.

1. Usethe A and V keys to browse the root of the
Compact Flash card.

2. Press SHOW to check the highlighted JPEG logo.

NOTE: The command module can only display pictures
with width and height multiple of 16 pixels. Pictures

of other sizes will not be displayed by the command
module but will work in the final report.

3. Press SEL to select the desired logo file and OK
to confirm.

4. Press REMOV to remove the current logo file.

5. Press <] to exit.

Use this field to store your company or trading name
(80 char max).

Use this field to record the name of the crew or individual
who is in charge of the P350 flexitrax (30 char max).

Use this field to record your company’s street address
(50 char max).

Use this field to record your company’s city or town
(20 char max).

Use this field to record your company’s post or zip code
(10 char max).

Use this field to record your company’s contact telephone
number (20 char max).
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Use this field to record your company’s fax number
(20 char max).

Use this field to record your company’s contact email
address (30 char max).

4.11 Splash and video title screens

The P350 flexitrax features several splash and information
screens.

4.11.1 Splash screens

The P350 flexitrax command module displays two splash
screens at start up. The first is the Pearpoint splash screen.
This screen is fixed and will appear during start up.

The second splash screen is optional and you can use
your own graphic, such as a logo. This screen will appear
after the Pearpoint logo and before the welcome screen
(Section 4.4).

Your company may already have a logo or other image
suitable for use as a splash screen. If not then you can
create your own splash screen in an image editor such as
Adobe Photoshop or Microsoft Paint.

NOTE: Your image must in JPEG format with horizontal
and vertical dimension in multiples of 16 pixels and size
not larger than 768 by 576 pixels.

Save your image as “splash.jpg” and copy the file to root
folder of the Compact Flash card. For more information
on copying files from your computer to the Compact
Flash card please refer to Section 6.7.

4.11.2 Video title screen

You can insert a short title screen at the beginning of
your recordings. The title page, if enabled, will add a

few frames containing information to the start of a video
recording. The title page is illustrated in Figure 4.8.To
enable or disable the video title screen go to DVR->TITLE.
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Figure 4.8: Video title page
B4-12-87
Company: Rodiodetecti
Crew: BREQEELIon
B4-12- B BESC O
331 -

Real J8m

HRodiodetection

Powered by

1. Select Title ON or Title OFF by using the /\ or \/
keys.

2. Press OK to confirm your choice.
The title page includes the following information:
e Company name.
e Crew name.
¢ Date and Time.
¢ Reel or drum type.

The company and crew name are taken from your
company details stored in the P350 flexitrax. See Section
4.10 for more information.

4.12 Ethernet configuration

You can connect the P350 command module to a PC
running a compatible reporting software to control OSD
and text position as well as retrieving telemetry data.

Ensure that you have the latest software installed. See
section 9.3 for more detalils.

Please note that the boot-up time for the command
module will be longer if no ethernet connection is present.

To connect to a PC you may use a standard or a crossed
patch RJ45 leads connected to the RJ45 receptacle in
the command module I/0 panel (fig 2.2 item 15).

Use the standard RJ45 straight lead if you are connecting
through a network hub or a router.

Use the crossed patch lead if you are connecting to a
PC directly.



To configure the ethernet port, go to SETUP -> COMMS
-> ETH. See Figure 4.9.

Figure 4.9: Ethernet configuration

Ethernet Confiqurdtion

Status indicates if the P350 system is connected or not.

Use the /\ and \/ arrows to select a setting and press
OK to edit it.

Boot Type: Choose between DHCP and Static IP.

If you choose Static IP you have to configure the following
three parameters:

e |P address: enter a valid IP address
e Subnet mask: enter a valid Subnet Mask

e Address gateway: enter a valid Address gateway.
You will need to to switch the system OFF then ON
to make the settings active.

4.13 Restoring factory settings

You can restore the command module to its factory
settings. Restoring the command module will erase all
your system settings, personal preferences and your
company details.

To reset the command module to factory default:
1. Go to SETUP and select RSTOR.

2. Select YES to continue or NO to cancel and
return to the previous screen.
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Section 5 - System operation

This section introduces the procedure for deploying the
P350 flexitrax system and inspecting pipes and conduits.

5.1 Emergency stop

The Emergency Stop button located on the PSU (item 6 in
Figure 2.7) will completely shut down the command module
and all system components when pressed. As a fail-safe, the
system must be reset before you can switch on the system
again. Do not reset the system until it is safe to do so. To
reset the system ensure the power is switched off at the
main switch (item 2 in Figure 2.7), rotate the Emergency Stop
button clockwise and then switch the power back on.

NOTE: Initiating an Emergency Stop may result in loss
of data on the Compact Flash card, particularly if a
recording or playback was in progress.

5.2 Deployment

Once the system is correctly installed, you can deploy the
crawler in the pipe or conduit you wish to survey. Care
must be taken when deploying the crawler, particularly if
it is being deployed into deep conduits and cisterns via
manholes with limited access.

WARNING: The crawlers are heavy! Observe proper
lifting procedures when handling, deploying and
retrieving the crawler.

Never lower crawlers or other heavy equipment
into manholes while personnel are working in the
manhole.

A

5.2.1 Before deployment

Assess your deployment and safety requirements before
you begin. Different environments may pose risks and
challenges that you may be unaccustomed to.

Check that no hazardous gases are present. The P350
flexitrax is not suitable for use in potentially explosive
environments.

The crawlers are heavy and may be difficult for one
person to lift and guide into position.

Seek assistance if required and always use correct
heavy-lifting practices.
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Pearpoint recommend the use of downhole (Figure 5.1)
and manhole rollers as there is a risk of scoring or
damaging cables during deployment and during a
survey. For more information see Section 5.2.3.

Figure 5.1: Downhole cable rollers

5.2.2 Using the crawler deployment tool

The crawler deployment tool has the following components
(Figure 5.2):

Toggle clamp

Crawler grab
e Bowden cable

e 4 interconnecting rods

Figure 5.2: Crawler grab kit

1 Crawler grab
2 Toggle clamp
3 Bowden cable

Before you attempt to assemble and use the crawler grab
tool, ensure that all parts are included in the kit.

A



Figure 5.3: Crawler grab setup

ﬁLL’ Toggle Clamp

Open position

Connecting Bars

Bowden cable
clamping screws

Holding screws

Without assembling the positioning rods, place the
toggle clamp away from the crawler grab as far as
the bowden cable allows, ensuring a straight run
from the toggle clamp to the crawler grab.

Fully open the toggle clamp. Ensure the lower
connecting bar’s holding screws, at both ends,
are in the lowest position as per figure 5.3. If they
are proceed to point 6.

If an adjustment is required, slacken the 2-off
cable clamping screws (see figure 5.3).

Force open the two connecting bars as far as
possible and pull taut the cable using suitable tool
(i.e. pliers).

Fully tighten the cable clamping screws to secure
the now taut bowden cable in place.

Test adjusted deployment tool by opening/closing

Figure 5.4: Crawler grab and crawler

Assemble as many rods as are required by
screwing them together.

Attach the rods to the crawler grab.

Attach a sufficient length of durable rope to the
crawler grab.

Attach the toggle clamp to the top section of the rods.

Position the grab over the crawler (see Figure 5.4)
and close the toggle clamp to lock the crawler in
place.

If you are using the large adjustable elevator (see
Figure 5.5), lock the crawler grab to the elevator.

Check that the crawler is clamped securely.
Ensure the lower connecting bar’s holding screws,
at both ends, are in the upmost position as per
figure 5.6.

Use the grab rope to lower the crawler into
manhole. If required, adjusts the toggle clamp’s
position to ensure it remains above ground.

toggle clamp and noting responding action on NOTE: The crawler may spin as it descends; use the

crawler grab. rod to guide and steady the crawler.
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Figure 5.5: Crawler grab and crawler with attached elevator Figure 5.7: Lowering the crawler into a manhole

9. When the crawler reaches the bottom of the
manhole, use a combination of the rope and rods
to position the crawler in the desired orientation.

10. When the crawler is positioned to your
satisfaction, release the toggle clamp’s lever to
disengage the crawler.

11. Pull the crawler grab up to the surface.

5.2.3 Cable and manhole rollers

The optional cable deployment rollers (Figure 5.1 on

page 28 and Figure 5.8 below) help protect the cable
Figure 5.6: Crawler grab in the closed position from scoring on concrete and other abrasive materials.
Pearpoint recommmends that you always use cable
deployment and retrieval rollers.

Figure 5.8 demonstrates the use of a manhole roller and
the protective downhole tiger-tail rollers. Note the position

Toggle Clamp . .
of the tiger-tail roller below the surface.

Closed position L[ Figure 5.8: Using cable rollers

@ —o—=
il
o=

Manhole roller
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5.2.4 Distance counter and Auto
Stop point

Once you have deployed and positioned the crawler in
the manhole, using manhole rollers to protect the cable
and ensuring that the cable protection spring has cleared
the drum rollers (Item 14 in Figures 2.5 and Item 22 in
Figure 2.6), you should zero the distance counter.

The zero (0.0) position is used to decide when to stop the
system when reversing or retrieving the crawler. Thisis a
safety feature.

You can reset the counter to zero at any time during
operation by pressing the A and V keys simultaneously
or by pressing F10.

You can also set a different stop point called Auto Stop.
The system will stop reversing when this stop point is
reached.

To set this limit: move the crawler to desired counter
position, go to DRIVE->SETUP->DRUM and press ASTOP.

Please note that the Auto Stop position is saved by the
system and it will be active until is reset.

To reset the Auto Stop point: zero the counter and set this
to become the new Auto Stop limit.

To review the currently set Auto Stop limit go to
DRIVE->SETUP->DRUM and press INFO.

You can also enter a new distance (up to £327m).
1. Press FQ.

2. Enter the distance and press OK to confirm.

NOTE: Resetting or varying the distance counter during
a survey will render the automatic retrieval function
ineffective as the crawler will return to the new zero
position and not the point where the crawler began the
survey.

When in custom layout you can move the OSD counter
field around the screen to suit your preferences. See
section 4.5 for more information.

5.2.5 Sonde

The P354 and P356 crawlers feature an integrated,
multi-frequency sonde. The sonde allows you to locate
the crawler’s position using a Radiodetection cable and
pipe locator such as an RD7000DL.

You can choose the desired transmitting frequency in
the Sonde settings menu which you will find by going to
SETUP->SONDE from the main DRIVE menu.

1. Press POWER to activate or deactivate the sonde.

2. Usethe A and V keys to select the desired
transmitting frequency between: 521Hz, 640Hz,
8192Hz and 32768Hz.

3. Press OK to confirm the selection and exit to the
Previous menu.

You can also use the shortcut Fn + F5 to activate or de-
activate the sonde without having to enter the Sonde menu

For more information on locating the sonde, please refer to the
documentation that came with your cable and pipe locator.

5.3 Driving crawlers

This section provides detailed instructions for driving and
retrieving the P350 crawlers when used with the manual
or powered drum. Although the principle is the same,
the powered drum offers several automated features that
make it easy to retrieve the crawler automatically.

NOTE: Make sure you have set the correct wheel size
before you attempt to drive the crawler.

Pearpoint recommends that you practice driving the crawler
on the surface in a safe environment before attempting
to deploy the crawler underground for the first time. In
addition to practising driving techniques, it provides a
good opportunity to understand how the system operates.

5.3.1 System stop

You can stop the drive system, including the crawler and
the powered drum at any time by pressing the spacebar,
Ctrl + C or ().

NOTE: When using the keyboard the spacebar will only
work in drive mode. Press Ctrl +C or (@) to stop the
crawler under all circumstances.

When stopped the crawler will be in Brake mode. Press
the spacebar, Ctrl+C or (@) to toggle the Brake.

A

5.3.2 Drive mode and OSD

To drive a crawler, you must be in drive mode. You can
access drive mode by selecting the DRIVE option from
the main menu.

NOTE: If you have selected a Pushrod, the DRIVE menu
will be locked and ROD will be displayed by the OSD.

NOTE: The P350 Command Module, Drum and Crawler
need to run compatible software versions, otherwise
the system may not work correctly.

When accessing the drive mode the system will
automatically check the components’ software for
compatibility and or problems.
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If a valid application is missing on any of the components
as a result of a failed upload, a warning message will

be displayed recommending a software upgrade.
Subsequently a “no application” warning will be shown.

If the software loaded on a component is incompatible
with the rest of the system a warning message will be
displayed recommending a software upgrade.

When a software “mismatch” or a “no application” on a
component is reported, you need to complete a software
upgrade on that component to be able to use the system
(refer to Section 9.3.for a instructions on how to obtain the
latest software and how to perfrom a software upgrade).

In the DRIVE menu, the command module’s onscreen display
(OSD) (Figure 5.9) will provide you with critical information,
navigation and telemetry assistance as well as pan and tilt
camera controls (if available) using the mimic display.

The driving OSD includes the following information:

e Mode.
e Status.
e Time.
e Date.

e DVR status.
e Distance counter.

e Page.
e Numeric inclinometer.
e  Mimic.

Some information displayed on this screen can be hidden
or moved. See Section 4.5 for more information.

Figure 5.9: Driving mode 0SD

Mode  Status Time Date DVR Counter
MAN T'M 12:38:45 25-89-88 > 1.23m
Page I1 8 T&
Page number . Pitch

Mimic
I S
System menu
SETUPl RET AUTO EXIT

The mode indicator displays the current drive mode.
The indicated modes are:

e AUT: automatic mode.
e MAN: manual mode.
e RET: retrieval mode.
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NOTE: If the system is set to interface to a push rod
then the DRIVE menu will not be accessible and ROD
will be displayed in the MODE field of the OSD. See
Section 4.8.

The communication status (COMMS) provides important
information about connected devices and the integrity of the
connection signal. The following information is indicated:

e T: crawler present.

e B: crawler present and braked.
e P: powered drum connected.
e M: manual drum connected.

When the T or B and P or M icons are colored green

it means the devices are correctly connected and the
communication link is good. If the T or P change to red
then it means that either the crawler (T) or the powered
drum (P) has stalled or is about to stall.

If the T, P or M characters are not displayed then the
crawler, powered drum or external power supply are not
connected correctly or may be malfunctioning.

The system time and date are displayed on the top of the
OSD (Normal layout). The appearance of the time and date
is controlled using the OSD menu in the main SETUP menu.
Refer to Section 4.5 for more information on changing the
look, visibility or position of the date and time OSD fields.

This icon displays the current digital video recorder (DVR)
status. It indicates when a video is playing, recording,
when recording or playback is paused or if the video is
fast-forwarding or rewinding. It also indicates when a
JPEG picture is viewed on screen.

NOTE: This field is not recorded.

The distance counter indicates the crawler’s distance
from the 0.0 position in feet or meters, depending on how
you configured the command module (see Section 4.8).

To reset the counter, please refer to Section 5.2.4.

The tilt or inclinometer reading displays the crawler’s
inclination (or pitch) in degrees or gradients (percentage).

To change the inclinometer settings go to:
SETUP->TRACT->NPTCH from the main DRIVE menu.

You can reset the inclinometer at any time to zero; however
Pearpoint recommends that you zero the inclinometer prior
to deployment and when the crawler is level. Do not zero
the inclinometer unless the crawler is completely level,
otherwise the inclinometer readings will be incorrect.



To reset the inclinometer:

1. Press ZERO. The command module will prompt
you to check that the crawler is level.

2. Press OK to reset the inclinometer or press
3. CANCL to return the previous menu.

To set the inclinometer to degrees or a percentage:

1. Press DEG to display degrees or GRAD to display
the inclination as a percentage.

When in layout custom mode (see Section 4.5.2) you can
move the inclinometer OSD field around the screen or
hide it to suit your preferences.

You can change the OSD inclinometer settings in the
NPTCH OSD Menu, which you will find by going to
SETUP->0SD->NPTCH from the main DRIVE menu.

Press OnOff to display or hide the inclinometer OSD field.

or
1. Select POS and use the arrow keys to select the
position of the inclinometer on the screen.

2. Press OK to confirm your choice and return to the
previous screen
or
3. Press RSTOR to restore the position to the default
position on the normal layout.

5.3.3 Mimic

Mimic is an intuitive on-screen feature that helps you
control the movements of the crawler and the position of
the camera’s viewing angle (PT and PTZ cameras only).
Mimic will only appear in driving mode (if enabled) and is
dependent on the type of camera you are using.

The basic mimic display (Figure 5.10) appears by default
or when a P354 crawler is connected to the system. Basic
mimic features an artificial horizon and a speed indicator
that shows the crawler’s forward and reverse speed.

The artificial horizon (center line) indicates the crawler’s
inclination as it traverses the pipe. The horizon will rotate
clockwise or anticlockwise relative to the crawler’s roll and
move up or down relative to the crawler’s pitch; note that
pitch is also represented by the numeric inclinometer.

Figure 5.10: Basic mimic

MAN T M 12:38:45 25-R9-88 1.23m
Artificial horizon @
Speed bar

SETUP RET AUTO EXIT

Steering mimic (Figure 5.11) is displayed when a P356
crawler is connected to the system. In addition to the
features of the basic mimic, steering mimic features a
steering bar that indicates when the crawler is turning,
steering left or right and the speed at which it is moving.

Figure 5.11: Steering mimic

MAN T M 12:38:45 25-89-88 1.23m
Steering Bar H
T 1
SETUP RET AUTO EXIT

Pan and tilt camera mimic (Figure 5.12) is displayed
when a pan and tilt camera is connected to the

system. Pan and tilt camera mimic provides a two
dimensional representation of a pan and tilt camera’s
three dimensional range of movements. The mimic
cursor, represented by the square box, acts as a target,
which can be positioned using the following keys on the
keyboard:

e W (up).
A (left).
e S(goto).
¢ D (right).
e X (down).

Once you have positioned the cursor on the desired
position, press the S key and the camera will
automatically move itself to look at the target.

See 5.3.4 for more information on how to use the pan
and tilt mimic display.

Figure 5.12: Pan and tilt mimic with steering bar

MAN T M 12:38:45 25-89-88 1.23m
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When you use mimic to control the camera’s viewpoint,
the camera uses a series of calculations to determine

its current position and the new target. To do so it may
manoeuvre in an unexpected way. This is normal, please
be patient while the camera orients itself.

You can change the appearance of mimic to suit your
preferences. From the DRIVE menu go to:
SETUP->0SD->MIMIC and choose from the following
options:

¢ OnOFF: toggle mimic display on or off.

e POSITION: adjust the position of the mimic display
on screen.

1. Use the arrow keys to move the mimic display
around the screen.

2. Press OK to confirm your choice and to exit to
the previous menu.

e COLOR: change mimic’s color.

1. Usethe A and V arrows to choose the desired
mimic color.

2. Press OK to confirm your choice and to exit to
the previous menu.

5.3.4 Navigating with advanced mimic

The inner circle represents the camera’s ability to move
up to 90° directly up, down, left or right. The inner circle
allows you to point the camera in every direction in front
of the crawler. The upper semi-circular area represents
the area in front of and above the crawler. The lower
semi-circular area represents the area in front of and
below the crawler.

For example, if you press the A key until the cursor moves
to the 9 o’clock position on the inner circle and press the

Table 5.1: Advanced mimic controls

Figure 5.13 | Pan (Horizonal) | Rotate (Vertical)
1 45° 0°

2 45° 45°

3 45° 9Q0°

4 90° 0°

5 90° 45°

6 90° 9Q0°

7 135° 0°

8 135° 45°

9 135° 9Q0°
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S key the camera will swivel 90° to the left (Figure 5.13.4).
Likewise if you move the cursor to the 12 o’clock position
on the inner circle and press S the crawler will look 90° up
(Figure 5.13.6).

The outer circle represents the cameras remaining field

of vision between 90° and approximately 300° in any
direction. The upper semi-circular area represents the area
above and behind the crawler. The lower semi-circular area
represents the area below and behind the crawler.

For example, if you move the target cursor to the 12
o’clock position, half way between the inner and outer
circles, the camera will look directly above and behind by
135° (Figure 5.13.9).

See table 5.1 and fig 5.13 for more examples.

The best way to learn mimic is to practice moving the
camera while you can see the crawler. Start by moving
the cursor to the cardinal points of the both the inner and
outer circles and observe the camera’s behaviour when it
moves. Once you have mastered the basics, try different
points on each circle and then start experimenting in
targeting the areas between the circle lines.

5.3.5 Pitch profiler

When in drive mode you can activate the Pitch Profiler.
When this is activated the command module will create
a pitch log file that records distance against the crawler’s
pitch or inclination. The log file is saved in the current
working directory and can be later reviewed by using
the file browser (see section 6.3) or by using a PC. See
section 6.3.2 for information on the file name format.

From the DRIVE menu go to: SETUP->TRACT and press
PPROF to activate or to disable the Pitch Profiler and to
open or close the log file.

You can also press P on the keyboard to toggle the Pitch
Profiler directly form the DRIVE menu.

NOTE: Do not remove the CF card before disabling the
Pitch Profiler as this may corrupt its content.

Result

Camera Pans 45° Left

Camera Pans 45° Left & Rotates 45°
Camera Pans 45° Left & Rotates 90°
Camera Pans 90° Left

Camera Pans 90° Left & Rotates 45°
Camera Pans 90° Left & Rotates 90°
Camera Pans 135° Left

Camera Pans 135° Left & Rotates 45°
Camera Pans 135° Left & Rotates 90°



Figure 5.13: Advanced mimic controls
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Figure 5.13.2
Figure 5.13.5
Figure 5.13.8

Figure 5.13.4
Figure 5.13.7

Figure 5.13.1
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5.3.6 Manual system

NOTE: The P354 and P356 crawlers feature an
automatic roll-over drive correction system: if they
roll-over for any reason the direction of movement will
remain the same.

NOTE: There is no difference in operation between the
Manual or Automatic mode when moving the crawler
forwards.

To move the crawler forward, press A

Pressing the A arrow subsequent times will increase the
crawler’s forward speed incrementally. A sustained press
of the A key will accelerate the crawler until it reaches its
maximum speed or until you release the key.

To slow the crawler, press V Subsequent or sustained
presses will decelerate the crawler faster until it comes to
a stop.

NOTE: If you continue to press V when the crawler
has stopped, it will move in reverse. The crawler will
automatically stop when the cable counter reaches 0.0
or the Auto Stop point (if set).

A

Use the crank handle to retrieve the cable. Use the
manual wind layering handle to ensure the cable is laid
evenly in the drum.

You can reverse the crawler in Manual (MAN) or
Automatic (AUT). Press F3 to toggle between Automatic
and Manual driving modes.

In Manual mode, the crawler will start moving backwards
as soon as it is driven.

NOTE: A message will flash on your screen warning of a
cable hazard. This message will not be recorded to video.

Press V to reverse the crawler. Increase the speed by
holding or pressing V Decrease the speed by holding or
pressing /\.

Ensure that you retrieve the cable at the same or higher
speed than the crawler as this may cause the crawler to
get entangled in the cable and stall.

Use the crank handle to aid the operation.
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In AUT mode the crawler will not move backwards until it
detects that the cable is being retrieved. Automatic mode
is recommended for most situations.

To enable the crawler ensure to be in Automatic mode
and press V once.

NOTE: The mimic speed bar is disabled in automatic
mode. The crawler’s speed is automatically set to
match the retrieval speed of the cable.

The crawler will stop moving if the cable is no longer
retrieved.

5.3.7 Powered drum

NOTE: The P354 and P356 crawlers feature an
automatic roll-over drive correction system: if they
roll-over for any reason the direction of movement will
remain the same.

You can move the crawler forwards as soon as you enter
the DRIVE menu. To move the crawler forward, press /\.

Pressing /\ subsequent times will increase the crawler’s
forward speed incrementally. A sustained press of the A
key will accelerate the crawler until it reaches its maximum
speed or until you release the key.

To slow the crawler, press V Subsequent or sustained
presses will decelerate the crawler faster until it comes to
a stop.

NOTE: If you continue to press v when the crawler has
stopped, it will move in reverse.

NOTE: The crawler will automatically stop when the
cable counter reaches 0.0. However, the crawler’s
momentum may cause it to roll a short distance beyond
the 0.0 position. Please allow for this when you deploy
the camera and zero the distance counter.

The powered drum supports two driving modes:
automatic and manual. The main difference is that when
reversing in manual mode, the crawler and powered

drum operate independently. Manual driving gives you
more control over the crawler and drum but can increase
the risk of jamming the crawler wheels on the cable,
particularly if the crawler reverses over the cable. Press F3
to toggle between Auto and Manual driving modes.

As with forward movement, you must be in the DRIVE
menu to reverse the crawler. From a stationary position,
press V to reverse the crawler.



Pressing V subsequent times will increase the crawler
reverse speed incrementally.

Decrease the speed by holding or pressing A If you
continue to press A when the crawler has slowed to a
standstill, the crawler will start moving forwards.

In automatic mode, the powered drum will automatically
retrieve the cable as the crawler reverses. To avoid the
risk of jamming the wheels in the cable, the crawler will
reverse at a slower speed than the cable.

In manual mode however, the drum will not retrieve the
cable and you must synchronize the speed of the crawler
and the cable. To rewind the cable in manual mode, hold
the Fn key and press V on the keypad. Hold this key
combination to accelerate the rewind speed.

Decrease the speed by holding or pressing Fn + A

As already mentioned in section 5.2.4 the system will stop
reversing when the Auto Stop limit and the zero point
have been reached.

A

The powered drum features an automatic retrieval
function. This function is designed to retrieve the crawler
at a constant, optimal speed. This speed cannot be
altered.

To use automatic retrieval you must set the 0.0m/ft
position before you start the survey. To set the 0.0
position press A and V simultaneously when the crawler
is in the position you wish to retrieve it to.

NOTE: Automatic retrieval does not work when the
counter is displaying a negative or zero measurement.

To retrieve the crawler, select the RET option from the drive
menu. The system will ask you to confirm the currently
selected wheel size. Make sure this matches the wheel set
installed on the crawler and press OK to continue.

1. Press GO to begin retrieving the crawler. The
crawler will automatically stop once the cable
counter reaches the 0.0 position or the Auto Stop
point (if set).

2. Press CANCL to cancel the operation and return
to the drive menu.

If necessary, you can retrieve the crawler using the crank
handle to manually wind the cable back into the drum.
Before you start, disconnect the power lead to ensure
that the system is not powered.

The crank socket is located under the side panel closest
to the controller socket. The panel is secured with socket-
head screws. Remove this panel using a metric Allen key.

Figure 5.14: Crank handle for powered drum

Attach the crank handle to the crank socket located in
the gear on the top right-hand corner of the compartment
using the supplied socket head screws.

Figure 5.14 illustrates the crank handle installed in the
powered drum. Note the installation point.

A

5.3.8 Steering (P356 crawler only)

NOTE: Steering the P356 crawler is identical for both
the powered and manual system.

You can steer the P356 crawler left and right, allowing
you to navigate pipes with ease. The crawler steers by
changing the speed on the left or right motor.

You can steer the crawler when it is moving forwards,
backwards or when it is stationary. Steering whilst
reversing is possible in manual driving mode only.

Note: Steering whilst moving is proportional to the crawler
speed: the faster the crawler moves the bigger the steer.

When the crawler is stationary, it will turn on its own axis.
Be careful when turning in this fashion as the crawler may
become entangled in the cable.

To steer right, press [=>. Hold the key to turn faster.
To steer left, press <J. Hold the key to turn faster.
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Whilst moving you can achieve a tighter turn by using the
lock steer function.

In this mode one set of wheels will lock. This gives a tight
turn, but will reduce the crawlers pulling power.

You can lock steer the crawler by pressing ALT + < or
> at the same time.

You can stop the crawler steering at any time by pressing
A if stationary or moving forward or v when reversing in
manual mode. If the crawler is moving it will stop steering
and continue to move in the same direction.

To stop turning the crawler when it is stationary you can
also press (@) or the spacebar.

5.3.9 Tractor power
You can control the power to the tractor and to the camera.
From the DRIVE menu go to: SETUP->TRACT
To remove the power to the downhole equipment:
1. Press POWER

2. Press YES to remove the power or NO to cancel

NOTE: If you power down the downhole equipment the
tractor brake will be disabled and live video will be lost.
To restore Power:

1. Press POWER

5.3.10 System diagnostics

The P350 system has built-in diagnostics. These run
automatically at start-up and every time you enter Drive
mode. If any problem is detected, a message will be
displayed, describing the fault and the recommended
actions to be carried out.

This is the list of faults and recommended actions:

Actions
(before consulting service)

Faults

Interface module error -

Check for drum connected
and powered, check link
cable

Check link cable

Check for tractor
connected, check down-
hole cable, check tractor
connector

No Drum control, no video

No Drum control

No Tractor control, no video

No Tractor control Check down-hole cable,

check tractor connector

Check for camera
connected, check camera
connector

No camera control, no video
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No camera control Check camera connector

No video, no video at Drum | Check tractor connector,
check down-hole cable,

check camera connector

No video, video at Drum OK | Check link cable

No application running on

drum/tractor/camera Upload software

Get latest software and
update

Software mismatch

Press OK to close the fault message and continue
operations.

If the fault is such that you require further assistance from
a service centre please make a note of the fault reported
and how this developed.

The system also automatically logs all issues in a log file
which can be found in the root of the CF card. The file is
called Controller_Log.txt and it should be made available
for reference to the service personnel.

5.4 Video recording

Recording video is simple. Before you begin a recording,
make sure you have installed a high quality Compact
Flash card with sufficient free space to store your
recording. Refer to Section 6 for more information about
using and selecting Compact Flash cards.

A

To begin recording press (); a red circle will appear on-
screen to indicate that a recording has begun.

If required, connect the optional headset to record audio
commentary over the video.

To pause a recording, press [J[|. Press O or [J] button to
resume your recording.

To end the recording, press [_] on the keypad or press
ESC on the keyboard.

NOTE: Recordings are automatically limited to a
maximum of approximately 2 hours. Recordings
exceeding 2 hours will be split into multiple files.

Pearpoint recommmends limiting recordings to a maximum
of 30 minutes to optimize video post-processing on a
computer.

For more information about digital video, including how to
set recording quality, please refer to Section 8.



5.5 Still pictures

You can save a screenshot of what is shown on the
screen at any time, even during recording or playback of
a video.

You can use these pictures in reports or just as a
photographic evidence of your surveys.

To take a screenshot press the [O] button (please note
that any recording or playback will pause whilst the
picture is saved onto the Compact Flash card).

The screen will display a “Please Wait” message to
indicate that the picture is being saved followed by the file
name; recording or playback will resume automatically.

For information on reviewing pictures or transferring them
by Bluetooth see section 6.5

Note: The picture taken will display exactly what is shown
on the screen including any digital enhancements (zoom,
pan or rotate). The on-screen display menu will not be
captured.

5.6 Camera controls

The P350 cameras have a range of features to help you
locate faults in more demanding conditions.

5.6.1 Lights

All cameras feature LED floodlights to help illuminate
pipes and conduits. LED brightness is controlled using
the brightness controls on the keypad. Press % to reduce
or %CE)% to increase brightness.

If no auxiliary lighthead is used, press the brightness keys
simultaneously to toggle the lights off or switch them on
to their previous level.

5.6.2 Auxiliary lighthead

The camera’s LEDs and the auxiliary lighthead can be
operated simultaneously or independently. If a lighthead is
connected, simultaneously pressing the brightness keys
will toggle the light controls between the following modes:

e Light control: ALL. Adjust both the camera and
lighthead in series.

¢ Light Control: AUX. Adjust the lighthead only.
e | ight control: CAMERA. Adjust the camera only.

When selected, the light control mode will flash on-screen
and fade. Use the brightness keys to adjust the lighting level.

NOTE: When a lighthead is connected you cannot toggle
the lights on and off using a simultaneous press of the
brightness keys as this will change the control mode. To
switch of the lights when a lighthead is connected, press
the button until the lights are switched off.

A\ WARNING! The camera and lighthead LEDs are
very powerful. Do not look directly at the LEDs or
point them at other people.

5.6.3 Focus

You can manually adjust the focus of P350 cameras.

To focus in or out of the FW and PT camera’s subject,
press Fn key and  or <0¢

e

The P350-CAM-PTZ camera features automatic focus.
You can adjust the focus manually using the FN and

¥ or %(Z)i:-. To resume automatic focus mode press

FN, # and 5% simultaneously.

NOTE: the P350-CAM-FW and P350-CAM-PT have a
focus range of 10mm (¥2") to infinity. The P350-CAM-
PTZ has a focus range of 10mm ('2") (WIDE) to infinity.

5.6.4 Pan

When using the P350-CAM-FW camera you can use
the pan function to digitally pan a zoomed-in picture on
screen.

To pan left or right, press Fn and @ or @ once to pan a
fixed step in that direction.

Press simultaneously Fn, @ and @ to reset the digital pan.

When using the P350-CAM-PT and P350-CAM-PTZ
cameras you can pan from side to side, giving a wide field
of vision without having to manoeuvre the whole crawler.

To pan left or right, press Fn and @ or @ once to start
panning in that direction. Press either key again to stop
the camera panning.

5.6.5 Tilt or rotate.

When using the P350-CAM-FW camera you can use the
rotate function to digitally rotate the picture on screen.

Press @ or @ once to digitally rotate of a fixed step the
picture clockwise or anti-clockwise

Press simultaneously @ and @ to reset the digital rotation.

The P350-CAM-PT and P350-CAM-PTZ cameras can
rotate. When combined with the pan function, you can
survey objects above and below the crawler.

To start to tilt/rotate the video on-screen clockwise
press @

To start to tilt/rotate the video on-screen anti-clockwise
press @

To stop rotating, press either key again.
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5.6.6 Center 5.8 Pendant controller

When using the P350-CAM-PT and P350-CAM-PTZ The P350 pendant controller is an optional accessory
you can return the camera to the forward view, leveled which allows the user to control the system remotely.
position by pressing @ and @ simultaneously.

Figure 5.15: Pendant controller

5.6.7 Zoom

The P350 system offers digital zoom capabilities when
used with the P350-CAM-FW and P350-Cam-PT.

The P350-CAM-PTZ camera features a 10x optical zoom.
The digital zoom is disabled when this camera is used.

[y

To zoom in on the camera’s subject, press @, .

l
To zoom out from the camera’s subject, press €. {%Jf .

To reset the zoom to x1 magnification, press €, and @

simultaneously. ﬁ;@’.ﬁs 50 \
°v @& IJ%n

5.7 Digital image controls STANDEY  Lauxn¥ MG

The P350 Command module offers sophisticated digital DRIVE
imaging control to allow you to manipulate the video )
displayed on the screen when playing back a recording or
displaying a video from an external video source.

5.7.1 Pan

You can use the pan function to digitally pan a zoomed-in
picture on screen.

To pan left or right, press Fn and @ or @ once to pan a
fixed step in that direction.

Press simultaneously Fn, @ and @ to reset the digital pan.

5.7.2 Rotate O
< > Ofmaer

You can use the rotate function to digitally rotate the TRIM - VRIM Opmaxs one
picture on screen. EAMERA

Press @ or @ once to digitally rotate of a fixed step the
picture clockwise or anti-clockwise

Press simultaneously @ and @ to reset the digital rotate.

5.7.3 Zoom

To zoom in press @, .

To zoom out press €.

To reset the zoom to x1 magnification, press € and @
simultaneously.

#(O #¥O B9 O

LIGHT SOURECE

& &2 sy
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The P350 pendant lead connects to the pendant
controller socket (item 7 in fig 2.7) on the powered drum
or manual PSU.

NOTE: Do not connect or remove the pendant
controller when the P350 system is turned on.

The pendant is enabled by pressing and holding the
[STANDBY] key. When the pendant is active, the
pendant ‘ON’ indication light will turn green and the word
‘pendant’ will appear at the bottom of the screen on the
command module. When the pendant is inactive, the
‘ON’ indication light will turn red.

NOTE: To prevent inadvertent operation of the P350
system the controls on P350 command module will be
disabled whilst the pendant is active. However, it is still
possible to record. To return control to the command
module press & hold this key.

By using the [+] and [-] keys, the head can be moved up
and down, or side to side, depending on the angle of the
head. When used in conjunction with the rotate facility,
the camera can view along different axes depending on
the orientation of the head.

NOTE: On FW cameras, this will be provided by the
controllers ‘soft/digital pan function’.

By using the [+] and [-] keys, the head can be rotated
clockwise and anti-clockwise. If used in conjunction with
the Pan facility, the effect will be to ‘sweep’ the view of the
wall of the pipe.

Note: On FW cameras, this will be provided by the
controllers ‘soft/digital rotate function’.

To zoom in to distant objects, press [+].

To zoom out from near objects, press [-].

NOTE: On FW/PT cameras, this will be provided by the
controllers ‘soft/digital zoom function’.

To focus on distant objects, press [+].

To focus on near objects, press [-].

NOTE: Continuous pressing of either [+] or [-] key will
result in ‘wrap around’ of camera focus i.e. in focus
— out of focus — in focus.

On occasion, there may be a requirement for manual
control of the iris to change the picture brightness (e.g.
to reduce a reflective glint from a shiny surface). Manually
opening the iris to maximum aperture will allow more light
to enter the camera giving a brighter picture. Closing the
iris to the minimum aperture will decrease the amount of
light entering the camera giving a darker picture.

1. Press the [SELECT] key until the ‘MAN’ indication
light comes on.

2. For a brighter picture, press the large ‘O’ key for
the maximum aperture.

3. For a darker picture, press the small ‘0’ key for
the minimum aperture.

The crawler lighting control allows the user to alternate &
adjust intensity between camera lights, auxiliary lighthead
(if available) and no lights.

1. To select lights, press the [SELECT] key
repeatedly until the appropriate indication light is
illuminated.

a.  To adjust camera lights, select the ‘CAM’
indication light.

b.  To adjust auxiliary lights, select the ‘AUX’
indication light.

c.  To adjust both camera & auxiliary lights in
series, select the ‘CAM’ & ‘AUX’ indication
lights.

d.  To turn off all lights, select the ‘NONE’
indication light.

Use these keys to adjust camera and/or auxiliary lighting
taking note which of the above options is selected.

To increase available light, press the large ‘ADD SYMBOL’
key.

To decrease available light, press the small ‘ADD
SYMBOL key.

NOTE: If there is an auxiliary lighthead fitted, and both
‘CAM’ & ‘AUX’ indicator lights are on the large ‘sun’ key
will firstly ramp up the camera lights prior to ramping
the auxiliary lights.
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Pressing the [SCAN] key will cause the camera to centre
itself, pan 90° and roll through 360° to scan the periphery
of the image. The scan can only commence if the green
‘READY” indication light is illuminated. This light will not
illuminate when the scan is under way.

NOTE: This function is not available for fixed forward
view cameras.

AUX (1), AUX (2) & AUX (3)

The ‘AUX’ keys currently have no function. These keys are
for future expansion.

To centre the camera, press [CEN] key. Once the camera
is centered the ‘CENTRED’ indication light will illuminate.

NOTE: This indication light will not illuminate whilst
using fixed forward view cameras.

To toggle between display states of onscreen mimic press
the [MIMIC] key.

Pan and tilt camera mimic is displayed when a pan & tilt
camera is connected to the system. Pan and tilt camera
mimic provides a two dimensional representation of a pan
and tilt camera’s three dimensional range of movements.
The mimic cursor, represented by the square box, acts as
a target, which can be positioned by pressing the joystick
either left, right, up or down. Once the cursor has been
placed at the desired position, depressing the [GO] button
on the joystick will move the camera to point at the target.

See 5.3.4 for more information on how to use the pan
and tilt mimic display.

NOTE: Joystick function is not available for fixed
forward view cameras

Pressing the bottom red [STOP] key will stop crawler
motion and apply the brake in addition to turning the
indication light red. The [STOP] key will toggle the brake if
the crawler is not in motion.

NOTE: When the crawler is active this indication light
will be green.
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Pressing the [SELECT] key will disable the sonde and
cycle through the four available sonde frequencies.
Sonde frequency is shown on the adjacent indicator pair.

Pressing the [ENABLE] key will activate the crawlers
sonde and illuminate the indication light amber.

Pressing the [ENABLE] key a second time will toggle the
sonde off and the indication light will turn off.

NOTE: The last selected sonde frequency will still be
lit regardless of the sonde status as the sonde is only
active if the amber indication light is on.

The ‘MODE’ section comprises the following controls:

Pressing the [1] or [{/] key allows selection of the
following functions:

(i) MAN (Manual). This will allows full manual control of the
crawler & drum using the [+] and [-] buttons.

To increase the drum pull speed, press drum speed]-].

To decrease the drum pull speed, press drum speed[+].

NOTE: These keys allow control of the speed of
the drum when in ‘MAN’ (manual) mode only. When
selected, the ‘MAN’ indication light will be illuminated.

(i) RET (Retrieve). Selecting ‘RET’ and then pressing

[GOJ key will cause the drum to automatically retrieve the
crawler providing the correct crawler wheel size has been
entered into the controller.

NOTE: When selected, the ‘RET’ indication light will be
illuminated.

(i) AUTO (Automatic). Selecting ‘AUTO’ will allow the
crawler to pull cable from the drum as it is driven forward.
In reverse, the drum will pull both cable and crawler at
constant speed, providing the correct crawler wheel size
has been entered into the controller,

NOTE: When selected, the ‘AUTO’ indication light
will be illuminated. Whilst cable is being retrieved the
‘DRUM ACTIVE’ indication light will illuminate green.

Pressing either red [STOP] key will stop all crawler motion
and apply the brake. If the crawler is not in motion,
pressing the [STOP] key will toggle the brake

Refer to section 5.3.6 & 5.3.7 for further information.

Improvement: No wheel size selection on retrieve as per
command module



In manual mode
To increase the speed of the crawler, press [+].

To decrease the speed of the crawler, press [-].

Pushing the joystick upwards will increase the crawler’s
forward speed incrementally. A sustained push of the
joystick will accelerate the crawler until it reaches its
maximum speed or until the joystick is released.

Conversely pulling the joystick backwards will decrease
the crawler’s forward speed incrementally. A sustained
pull of the joystick will decelerate the crawler until it stops.

AUTO (Auto mode): Continuous pulling of the joystick will
result in crawler retrieval.

MAN (Manual mode): Continuous pulling of the joystick
will drive the crawler backwards.

Depressing the [STOP] button on the joystick will stop all
crawler motion and apply the brake in addition to turning
the indication light red.

NOTE: A green indication light will be shown for the
direction the crawler is travelling i.e. forwards or
backwards.

Pushing the joystick to the left or to the right will cause
the crawler to steer in the required direction. A sustained
press left or right will increase the rate of steer whilst
increasing the speed of the crawler.

Note: If the crawler is steering to the left, tapping the
joystick to the right will invert the crawlers heading.

Refer to section 5.3.8 for further information.

To turn the crawler using the [TRIM] keys:

Pressing the left or right trim key will increment the trim
offset. For example, if you press the left trim button while
the crawler is driving straight ahead, the crawler will begin
to move fractionally to the left. Pressing the left key again
will increase the left trim. Pressing the right trim key will
now reduce the left trim. Pressing right again will cancel
the trim

Trim may only be changed while the crawler is in motion.

The crawler will retain its trim setting through power
cycles and on other P350 systems.

Pressing both [TRIM] keys together will cancel the trim
command and the crawler will resume a straight ahead
course.

5.9 Retrieving the crawler

To retrieve the crawler safely and securely, Pearpoint
recommends using the accessory deployment tool.

Guide the crawler to an easily accessible position using
the drive controls.

Prepare the grab, rods and clamp as described in Section
5.2.2 if you have not already done so.

A

1. Using the rope, lower the crawler grab tool and
ensure the operating handle remains above the
surface.

2. Secure the crawler grab to the crawler’s chassis (or
elevator if used); this may take several attempts.

3. Lock the crawler grab using the toggle clamp
(see fig 5.4).

4. Test that the connection is secure by lifting the
crawler using the rope.

5. If the connection is secure, lift the crawler to the
surface using the rope.

6. When the crawler is on the surface and in a
secure location, disengage the clamp to release
the crawler.

7. Disassemble the rods.

8. Clean and disinfect the crawler, rods and crawler
grab as required.
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Section 6 - File management
and Transfer

The P350 flexitrax uses a Compact Flash (CF) card to  Figure 6.2: CARD menu
store all video, images, text entries and report files.
A two gigabyte card will store up to 1 hour and 45
minutes of video using the high-quality video setting
(refer to Section 8 for more information about video
quality and recording times).

A WARNING! Do not remove or insert the CF card
when the unit is ON. Do not cycle the power when
recording or playing. Failure to comply may damage
the CF card and corrupt your data.

The command module will display a warning (Figure 6.1)
the first time the CF card is accessed or utilized.

Figure 6.1 Compact Flash card warning page

6.1.1 Destination folder

WARNING!
The destination folder (DESTN) menu allows you to define
Do not remo ve or inser t the the default working directory where the command module
Comp N ( ;Zf" ) when t will store new reports, videos and pictures.
unit ' Jo not cycle
power when o Use this command to organize, if you wish, your survey’s
in Failur v data in different folders: one for each job for example.

A

na ge the CF and See Section 6.3.1 for more information on organizing
rrupt the recording your work.

continue 1. Enter the DESTN menu.
) ) 2. Press NEW.
The command module provides two modes for handling
compact flash cards: the CARD menu and the file 3. Enter a new name and press OK.
browser.
The CARD menu (Section 6.1) allows you to perform
general operations on the installed card. 1. Enter the DESTN menu.
The file browser (Section 6.3) allows you to browse and 2. Select a folder using the A and v arrows.
manage files and folders stored on the card.
3. Press SET.

6.1 CARD menu

The CARD menu allows you to set the current default 1. Enter the DESTN menu.
directory, access reports, check the card status and
format the card.

Press CARD to enter the Card Menu (Figure 6.2).

Select a file or folder using the /\ and \/ arrows.
Press RENAM.

A 0N

Enter a new name and press OK.
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6.1.2 Reports

The reports (REPOR) menu allows you to create, edit or
delete reports. For more information on reports, please
refer to Section 7.4.

NOTE: The CARD menu allows you to access any
report stored on the CF card whereas the || menu
allows you to edit the report saved in the current default
folder only.

6.1.3 Card status

The Compact Flash card status window displays critical
information about the state of the currently installed card.
The status screen is displayed after the command module
performs a series of tests to check the card’s memory.

1. Enter the CARD menu. Press CHECK.

2. This system will prompt you to wait and then
display the card status window (Figure 6.3).

Figure 6.3: Compact Flash card status page

Status

CompactFlash

Mbps
Mbps

Lo Ccontlnue

The status screen displays the following information:
e total: overall available memory in MB (megabytes).
¢ free: free memory in MB.
e ysed: used memory in MB.
* bad: bad memory in MB.

¢ Write Speed: write speed in Mbps (megabits per
seconds).

e Read speed: read speed in Mbps.

NOTE: Format the Compact Flash Card if any bad
sectors are found. If the Bad sector persists replace the
Compact Flash card.

6.1.4 Formatting the card

The command module can format your Compact Flash
card. If you purchase a new Compact Flash card, be sure
to format it using the command module. If you format

the card using your PC or Mac, format the card using the
FAT32 file system.

Cards formatted in different formats or by a media player
or digital camera may not work.

NOTE: In Mac OS X, the FAT32 file system is referred to
as MS-DOS format.

A

1. Select CARD from the Main Menu.
2. Select FMT.

3. Press YES to confirm the format operation or NO
to cancel.

6.2 Supported card types

The P350 flexitrax system supports high-speed (40x and
write speed of 6 Mbps minimum) TYPE 1 high quality
Compact Flash cards with a capacity of up to sixteen
gigabytes (16GB). This is the minimum requirement for
high quality video recordings.

NOTE: There are other Compact Flash cards technical
specifications that may affect a Compact Flash card’s
performance or compatibility with the P350 system.
These specifications may not be documented by the
card’s manufacturer or retailer.

A WARNING: Kingston cards are not supported due
to technical compatibility issues.

For the best results, only use cards that have been
formatted by the P350 flexitrax command module.

Please contact your local Pearpoint representative for the
latest list of recommended cards.

Using low speed or low quality cards may degrade the
video recording quality or cause the recording to hang or
render the system unstable.

P350 flexitrax Operation Manual 45



6.3 File browser

The P350 flexitrax system features a basic file manager
(Figure 6.4) that allows you to create, edit and delete files
and folders.

NOTE: Folders are sometimes referred to as directories.

Figure 6.4: Gompact Flash browser

< File

browser >

otal, 194TMB free

WO INFO

NOTE: You can view folders created by the P350
flexitrax in Windows Explorer or the Mac OS X Finder
when you connect the command module to your
computer via USB connection (see Section 6.6 for
information on USB connections). The P350 card
browser will only display compatible files: JPEG, MP4,
TXT, BIN and HTML. BIN and HTML files are listed only
and cannot be viewed on the command module.

TXT files can only be viewed if smaller than 1Mbyte.

6.3.1 Organizing your work

The command module automatically creates a new
default folder at the start of each day’s operation. The
folder is named after the day it was created, for example
[80Nov] and is saved in the DVC folder on the Compact
Flash card.

Once created, the new folder will serve as the default
location for all new videos, images and reports taken on
that day. If you prefer to organize each inspection job in a
different folder you can do this by manually setting a new
folder (or an existing one) as the new default folder where
new files are saved to (see Section 6.1.1 or 8.3.2).

For example you may wish to organize your recordings in
different folders, one for each job.

NOTE: At startup the system will default to a directory
based on today’s date. For example: 01Jan for the first
of January.
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6.3.2 Filename structure

Each video, picture or pitch log file is created by

the command module with the following structure:
ddmmmxxx.ext where dd is the day number, mmm is
the month, xxx is a counter and ext is the file extension.

For example: 140CT001.MP4.

You can customize the file name by adding a prefix to it.
Refer to Section 8.3.3.

NOTE: File extensions on the P350 command module
are case sensitive.

1. Enter the CARD menu and press OK or press the
video [> (play) key.

2. The command module will list any folders on the
Compact Flash card; Folders are indicated by
[square brackets] for example [05Nov].

3. The current location in the folder structure is
shown below the Card Status line, for example
/DVC indicates that your current position is in the
Compact Flash card’s DVC folder. The / by itself
denotes the Compact Flash card’s top level or
root folder.

4. To enter a folder, select it with the A and V
arrows and press OK or Enter.

5. The screen will now display any sub-directories
and files located in the folder you selected.

6. To return to the parent folder press the <] keypad
arrow or select the [..] icon and press OK or Enter.

NOTE: The P350 File browser will only show files that
are supported by the command module. These are
video files and JPEG pictures created by the unit and
with a MP4 and JPEG extension. HTML files are also
shown but are not viewable.

6.3.3 Copying files

You can copy any file on the Compact Flash card
to the current folder or to a different location.

1. Select the file you wish to copy using
the A or V arrows.

2. Press COPY.

3. Navigate to the folder you want to copy the file to
and press SEL.

NOTE: The command module will automatically provide
a default copy name for example Copy_of_05Nov03.
JPEG. Once the file is copied, you can rename it as
required.



6.3.4 Moving files and folders
1. Select a file or folder using the A and V arrows.
2. Press MOVE.

3. Navigate to the folder you want to move the file or
folder to and press SEL.

6.3.5 Renaming files and folders

You can rename any file or folder on the Compact
Flash card. The system will add the default extension
automatically.

1. Select afile or folder using the A and V arrows.
2. Press RENAM.

3. Enter a new name and press OK.

A

6.3.6 Deleting files and folders

You can delete any file and folder on the Compact Flash
card using the command module.

Figure 6.5 shows the delete functions in the file browser.

Figure 6.5: File browser delete and show screen

o HOW

1. Select a file or folder using the A and V arrows.
2. Mark the file or folder by pressing the [>> arrow.

3. Repeat the previous two steps if you wish to
delete multiple files or folders.

4. Alternatively, press +ALL to mark all the files and
folders included in the current folder or -ALL to
deselect them alll.

5. Press DEL.

6. Select YES to confirm the delete operation or NO
to cancel.

A

Note: You can also use the DEL button on the
keyboard.

6.3.7 Creating folders

You can create new directories in any location of the
Compact Flash card.

1. Enter the folder where you wish to create the
new subfolder.

2. Select DIR.
3. Enter the new folder's name and press OK.

Once the folder is created you can move or copy files to
it as with any folder on the card or set it as hew default
working folder. See section 6.1.1 or 8.3.2 for more details.

6.3.8 Sending a file with Bluetooth®:

You can send a file directly to your compatible Bluetooth®
handheld device.

1. Select a file using the /\ and \/ arrows.
2. Press SEND.

Refer to Section 6.8 for more information on how to send
files using Bluetooth®.

6.3.9 Information

You can access files and folders information.
1. Select a file or folder using the A and V arrows.
2. Press INFO to access the information:
e File Extension or Directory
* File Size
e Read Only attribute
* Hidden attribute
* Date and time of creation

3. Press OK to continue.

6.4 Viewing Pitch Log

The file browser allows you to view pitch log files created
by the P350 system.

NOTE: Pitch log TXT files can only be viewed if smaller
than 1Mbyte. Larger files will have to be opened using
a PC.
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To view a pitch log file:
1. Select a TXT file using the A and V arrows.

2. Press OK or Enter to display the log file
on-screen.

3. Press /\ or \/ or PG Up or PG Dn to scroll
through the data.

4. Press OK to close the file.

6.5 Viewing JPEG pictures

The file browser allows you to view JPEG image files
created by the P350 system. When a picture is displayed
on-screen a Camera symbol will appear in the DVR
section of the OSD.

NOTE: JPEG pictures that were not created by the
P350 flexitrax system may not be compatible with the
command module. Pictures will only be displayed if
their horizontal and vertical dimensions are multiples of
16. For example a picture with the dimensions 720x480
pixels is acceptable whereas 800x600 pixels is not.

1. Select a JPG file using the A and V arrows.

2. Press OK or Enter to display the picture
on-screen.

3. Press /\ or \/ to view any other JPEGs stored in
the folder.

4, Press |:| to return to the file browser.

5. Press W, X, A and D to pan up, down, left and
right respectively. Press S to reset the panning.

You can select more than one file to restrict your browsing
to the selected one. See figure 6.5.

1. Select a JPG file using the /\ and \/ arrows.
2. Mark the file by pressing the > arrow.

3. Repeat the previous two steps for every JPEG file
you wish to view or press + ALL or -ALL to select
or deselct all the files present in the folder.

4. Press SHOW.

5. Usethe A and V arrows to scroll through your
selected images or [T +to retumn to the file browser.

You can display a slideshow of all pictures contained in
the folder or of the multiple pictures you have selected:

1. Press SSHOW.
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2. Usethe /\ and \/ arrows to select your preferred
transition time (3 to 20 Sec).

3. Press OK to confirm your choice and start the
slideshow.

4. Press|_|to stop the slideshow.

As with any other small file, you can send a JPG file
directly to you compatible Bluetooth® handheld device.
See section 6.3.8.

You can also send a picture whilst this is displayed on the
screen:

1. Select and display the picture you wish to send.
2. Press SEND.

Refer to Section 6.8 for more information on how to send
files using Bluetooth®.

You can access files and folders information.
1. Select a file or folder using the A and V arrows.
Press INFO to access the information:
File Extension or Directory.
File Size.
Read Only attribute.
Hidden attribute.

Date and time of creation.

® N o ok~ N

Press OK to continue.

6.6 Playing videos

You can play a recorded video and view it on the P350
flexitrax LCD or on any external monitor connected to the
video output jacks on the command module, powered
drum or external PSU.

Note: If using an external monitor to display the video,
this may not display the entire picture as shown and
recorded by the P350 command module. The size of
the picture displayed will vary between monitors and it
is dependent on the monitor’s analog input and video
resolution specifications.

To playback a video:

1. Usethe /\ and \/ arrows to select the file you
wish to playback.

2. Press > or OK to start the playback.

3. Press [|[] to pause the video at any time.



4. Press <] or > to FF or RW. To resume normal
playback speed, press (][] and then press video [>>.

5. Press VOL- and VOL+ to adjust the audio volume
(if present).

6. Press | ] to stop the playback and go back to the
file browser.

7. Press W, X, A and D to pan up, down, left and
right respectively. Press S to reset the panning.

NOTE: The Playback OSD will fade from view after few
seconds.

You can use the digital imaging controls of the P350
command module, see Section 5.6, when playing back a
video to zoom, rotate or pan the picture on screen.

A

6.6.1 Screen captures

During recording or playback it is possible to capture
During playback it is possible to capture video frames as
JPEG photos. See Section 5.5 for more details.

6.7 USB connections

The P350 command module supports USB 2.0 to allow
high speed files transfer. USB is the recommended
method for transferring files between the command
module and your computer.

NOTE: The command module is compatible with
high-speed, powered USB ports. Connection to
external USB hubs or older 1.1 USB ports is not
recommended.

NOTE: Only use USB 2.0 graded cable to connect the
command module to your computer.

1. Switch the command module off for the duration
of the connection. The integrated card reader will
draw sufficient power from your computer’s USB
hub.

2. Ensure your computer is switched on and running.

3. Connect the supplied USB cable to the unit and
to a free USB port on your computer. Do not use
an external USB hub.

4. On Microsoft Windows-based computers, the
command module will appear as a Mass Storage
Device. It will be assigned with a drive letter, for

example E, and will be listed in the My Computer
window.

5. On Apple Macintosh computers, the card will
appear as an icon on the desktop and as a
source disk in the sources list on any Finder
window.

6. After your computer has mounted the card, open
it in Windows Explorer or Finder and then open
the DVC folder to retrieve your inspection files.

6.7.1 Disconnecting

A

To disconnect the command module from your computer
you must use the Windows USB hub manager (Figure
6.6) before removing the cable. To do so:

1. Locate the USB device icon on the Windows
Task Bar (usually bottom right-hand corner of the
screen). When you hover your mouse cursor over
this icon, a tool tip Safely Remove Hardware will
appear.

2. Left-click the icon with your mouse and click the
option to remove the command module.

3. A balloon popup will inform you that it is safe to
remove your hardware.

4. You can now disconnect the USB cable from the
computer and command module.

Figure 6.6: Windows USB hub manager
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1. Drag the card icon from your desktop to the
Trash. Alternatively select the card icon and press
CmdE.

2. Wait until the icon has disappeared from your
desktop or Finder window before you disconnect
the USB cable.

6.8 Bluetooth®

The P350 flexitrax features an integrated Bluetooth®
module that allows users to transfer files wirelessly from
the P350 command module to any compatible Bluetooth®
device such as a computer or mobile phone.

NOTE: Your device needs to support the Bluetooth®
Generic Object Exchange (or OBEX) profile. Be aware
that some devices only support the Headset (HSP) or
Hands-Free (HFP) Profile.

See section 6.3.8 for instruction on how to select a file
and send it via Bluetooth®.

NOTE: Your computer must have an integrated or USB
Bluetooth® module to receive files from the command
module. If your computer does not feature an
integrated Bluetooth® module then you can purchase
inexpensive third-party USB modules from computer
hardware suppliers.

Figure 6.7: Bluetooth® menu
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paired devices
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return to previous menu
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6.8.1 Pairing

Compatible Bluetooth® devices can be paired to the
command module. However, pairing is not necessary

to transfer a file. Pairing allows the command module

to discover and connect to your device quickly in an
environment where many Bluetooth® devices are present.
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You can pair the command module to most compatible
Bluetooth® devices, including computers, cell or mobile
phones and PDAs.

Before attempting to pair, make sure your device’s
Bluetooth® interface is switched on and set to visible or
discoverable. Consult your device’s documentation if you
need help to configure your device’s Bluetooth® settings.

1. Enter the Bluetooth menu (SETUP->COMMS-
>BT) or initiate a file transfer (See Figure 6.7).

2. Press SCAN to search for any nearby visible
devices.

3. If your device is detected (Figure 6.8), select it
using the A or v arrows and press PAIR. Press
SCAN if you cannot see your device.

4. You device will prompt you to enter a pass key.
Enter ‘12345’ and press Enter or OK, depending
on your device’s input (i.e. keyboard or keypad).

5. The system will display a message indicating if the
Pairing process is successful. Press OK to return
to the Bluetooth® menu.

The command module and your device are now paired.

NOTE: If you cannot see your device in the list after
repeated search attempts, check that your device’s
Bluetooth® module is on and the device is set to visible
or discoverable and it is within 10m (30 feet) of the
command module*. Refer to your device’s manual for
more information on Bluetooth® pairing.

*10m is the maximum range for Bluetooth® connections.
If you are near a Wi-Fi base station or in an area with a
large electromagnetic field, your connection range may be
reduced to less than 3 meters.

1. Press KNOWN to search for nearby paired
devices.

2. Press SCAN if you cannot see your device.

3. Select the device you wish to remove from your
paired list and press DEL.

4. Press <{to return to the Bluetooth® menu.

6.8.2 Transferring files

You can transfer files to any visible or paired device.



1. Use the file browser to select a file to transfer
(see Section 6.4).

2. Select SCAN to locate any nearby visible devices.
You can pair your device at this point (see Section
6.8.1).

3. Alternatively, select KNOWN to locate any nearby
paired devices.

4. If you device is listed, select it and press OK or
SEL.

5. The command module will now attempt to send
the file to your device. Follow your device’s
instructions on how to receive files (if any).

Figure 6.8: Bluetooth® device selection page
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NOTE: Bluetooth® enabled devices such as computers
and mobile phones will handle received files differently.
Your device may ask you to specify the location of

the received file. Some mobile phones however will
automatically receive and save the file into a default
location.

NOTE: Apple OS X 10.5 users must enable Bluetooth
Sharing in System Preferences (see Figure 6.9) to
receive files sent by the command module. The
Bluetooth Sharing menu also allows you to set how
OS X handles received files.

You can transfer any file on the card, however due to
the limited bandwidth supported by Bluetooth® it is
recommended that you send small files only. To transfer
video files, Pearpoint recommends using the USB
connection.

Figure 6.9: Mac 0S X Sharing preferences
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Section 7 - Inspection reports and

text pages

This section introduces the P350 flexitrax command
module’s integrated report writer and text page editor.

7.1 About reports and pages

During your survey you can choose to overlay a text page
on your recording or to create a report to document your
findings for audit or review.

Press |£| to enter the Text and Report menu (see Figure 7.1).

Figure 7.1: Text and Report menu
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If this menu is accessed during a recording then the
recording will automatically pause. The recording will
resume automatically when you complete your task and
exit the menu.

NOTE: If you are already editing a Report, pressing
will take you directly to the Report Menu. See 7.4 for
more information.

7.2 Defect Codes

The command module supports defect codes. This
feature helps you to save time and ensure consistency
when you create or edit reports. You can browse a defect
code list stored in a text file that is saved in root directory
of your Compact Flash (CF) card.

NOTE: the file must be present in the root of the CF
card for this to work.
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Obtain the latest “defect_codes.txt” file from the
Radiodetection website or create your own. See
Appendix 9.7 for more information on how to create or
edit a defect codes text file.

7.3 Video text pages

The P350 command module allows you to create, edit
and save up to 10 pages of text using the Report and
Text menu. The maximum number of characters that can
be entered depends on the font set used:

¢ Large fonts: 13 rows x 36 characters

e Small fonts: 21 rows x 45 characters

NOTE: Take care when editing your text pages so that
the resulting video recordings display all the information
required when it is converted to a DVD. See Section 8.5
for more info.

7.3.1 Browsing text pages
1. Usethe /\ and \/ arrows or Pageup and

PageDown to cycle through the pages; each
page is numbered 0 to 9.

7.3.2 Overlay selected page

1. Press OK to overlay the selected page and to exit
the Text menu.

NOTE: The page title is not recorded even if shown on
the screen

7.3.3 Remove text page
1. Press HIDE to remove the current overlaid page
and exit the Text menu.
7.3.4 Editing text pages

1. Press EDIT to modify the page currently displayed
(see Figure 7.2).

2. Use the keyboard or keypad to add or edit the text:



Figure 7.2 Video text editing page

The keyboard is fully featured; you can enter any available
character and use navigation keys such as Home, End
and the arrow keys to position the cursor.

1. To delete all text to left of the cursor, select DEL <.

2. To delete all text to the right of the cursor, select
DEL >.

3. To browse the defect codes file (if present) select
CODES.

4. Press Esc to undo your changes and exit the Text
menu
or

5. Press Enter to save your changes and exit the
Text menu
or

6. Press Pg Up or PG Dn to accept your changes
and select another page to modify.

You can enter text with the keypad arrows. Use the A or
\/ arrows to cycle through the list of available characters.
Use the <] and [>> arrows to move the cursor backwards
and forwards along the line.

1. To toggle between upper and lowercase press
CAPS.

2. To delete all text to left of the cursor, select DEL <.

3. To delete all text to the right of the cursor, select
DEL >.

4. To browse the defect codes file (if present) select
CODES.

5. Press CANCL to undo your changes and exit the
Text menu,

6. Press OK to save your changes and exit the Text
menu.

7.3.5 Changing text appearance

You can modify the text appearance by varying
character’s color and transparency.

1. Press COLOR to enter the color menu.

2. Use /\ and \/ to select the desired color font
and press OK to confirm the choice and exit.

1. Press TRANS to enter the transparency menu.

2. Use A and V to select the desired transparency
and press OK to confirm the choice and exit.

7.4 Reports

The P350 flexitrax system features an integrated report
writer that allows you to create inspection reports on site
using the command module. The report contains your
company and client details, observations, comments and
selected photos captured with the P350 flexitrax camera.

Reports are generated in HTML format and are
compatible with IE 6 or above. You can view or print
reports using any compatible PC, by accessing the report
folder on the Compact Flash card. This report can be
given directly to the customer or can be converted into
MS Word (Office 97 or later) for further editing.

NOTE: The P350 flexitrax command module cannot
display a report in its final format. It will however display
individual editable text entries.

Figure 7.3: Report menu
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7.4.1 Creating a new report

1. Press REPOR to enter the report menu (Figure 7.3).

2. Select NEW to create a new report in the default
working folder.

NOTE: You can create a new report in any other sub-
folder of the DVC folder in your Compact Flash card by
entering the CARD menu, selecting the sub-folder you
wish to create the report in and entering the report menu.

3. Type the report’s name and press OK. The system
will generate a blank report using the name you
specified as the report’s folder.

4. Once created, the command module will present
you with seven editable pages inside the report’s
data folder.

5. Usethe /\ and \/ keys or type the name of the
page using the keyboard to select any of the pages
you wish to edit and press OK to enter them.

6. Usethe /\ and \/ keys or enter a number with
the keyboard to browse the page’s fields. The
bottom row of the screen will show the field
content. Press OK to edit the content.

7. Once edited the field press OK

8. Press the < key to go back to the previous
menu. If pressed in the top menu it will return to
the live picture.

9. At any time you can toggle between the report
screen and the live video by pressing. Recording
will resume automatically.

10. Press CLOSE to close the report.

NOTE: You need to close a report to be able to access
text pages.

Figure 7.4: Report pages
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The seven editable pages are:

1. Client (see Section 7.4.2).
Company (see Section 7.4.3).
Freetext (see Section 7.4.4).
Observations (see Section 7.4.5).

Photos (see Section 7.4.6).

S T A

Site (see Section 7.4.7).
7. Survey (see Section 7.4.8).

These are detailed as follows.

7.4.2 Client

This page allows you to enter details about your client. You
can enter your client’s name, contact details and specify a
reference if required.

This information appears on the Report Details page.

1: ClientName: client’s company name or personal name
if the client is an individual (30 char max).

2: ClientRef; client’s reference (30 char max).

3: ClientContact: name of the client’s representative
if applicable (30 char max).

4: ClientPosition: contact’s position, for example manager,
landlord or tenant (30 char max).

5: ClientAddress: client’s address if different from the Site
address (see Section 7.4.7) (50 char max).

6: ClientTel: telephone number (20 char max).

7: ClientMob: mobile or cellular telephone number
(20 char max).

8: ClientEmail: email address (30 char max).

7.4.3 Company

This page details your company’s information. If you have
entered your company'’s details in the controller settings
(see Section 4.10) before you created the report then the
information is already in place. You can leave this page as
it is or edit as required.

NOTE: Any change to your company details will not
override what is already set in the main company menu
setting page.

The fields are explained in Section 4.10.

Use the A or v keys or enter a number using the
keyboard to select a field. Press OK to edit the desired
field.



7.4.4 Freetext

In each report, you can include a page containing free
form text limited to 468 characters. This is particularly
useful for notes or explanations that do not fit elsewhere
in the report. Set your Title in the FreeTitle field and then
enter your comments in the Bodly field.

Free text will appear in the generated report as the final
page in the document.

1: FreeTitle: use this field to give your comments a title.
In the report, the title appears as a subheading under
the Comments page title (30 char max).

2: Body: use this field to write your comments
(468 char max).

7.4.5 Observations

The observations page allows you to create a sequential,
annotated report of your survey. Each observation you
make (limited to 20 maximum) can include a position,
code, comments, the grade and a photo.

Use the A or V keys or enter a number using the
keyboard to select an observation field. Press OK to edit
the desired field.

The fields offer considerable flexibility and you can populate
them with information to suit your work practices. The only
exception is the ObsPhoto field, which requires you to
select a photo stored on the Compact Flash card.

NOTE: ensure to enter observations in a chronological
order. Do not skip observation fields as this may affect
the way the final HTML report will work

1: ObsPosition: record the position of your observation
(80 char max). The current counter reading is
automatically entered. You can edit this if you wish.

2: ObsCode: enter a defect code. There are 2 mutually
exclusive ways of editing this field: you can enter the
defect code manually or by browsing the defect code
file (if present). See Section 7.2 for more information.

3: ObsNotes: record your comments, such as a brief
description or assessment of the observation
(30 char max).

4: ObsGrade: grade your observation, if required. For
example, you could grade an observation by severity
of fault (30 char max).

5: ObsPhoto: add a JPEG image located in your current
default directory in the Compact Flash card. The
generated report will feature an in-line thumbnail of
this image.

Go to the ObsPhoto field and press OK. You can select
from the following options:

e SEL: Select the highlighted picture.
e SHOW: Show the highlighted picture.
¢ REMOV: Remove the selected picture.
1. Use /\ and \/ to highlight a JPEG file from the

current default directory.

2. Use SHOW to review the picture and SEL to
select it.

3. Press OK to confirm the choice of the selected file
and return to the previous directory.

4. Use REMOQOV to remove the selected file.

NOTE: An error message will appear if the picture
is not suitable.

When entering observations you can set up the command
module to display (popup) your observation code, notes and
grade automatically for a duration of 4 seconds in the middle
of the screen when resuming your survey if recording.

To enable or disable the observation popup go to
DVR-> REPOR.

7.4.6 Photos

With the photos form you can attach annotated pictures
(limited to 20 maximum) to the report.

Pictures will be shown in the generated report under the
Photos Small and Large pages.

Use the A or V keys or enter a number using the
keyboard to select a photo field. Press OK to edit the
desired field.

NOTE: ensure to enter photos in a chronological order.
Do not skip photo fields as this may affect the way the
final HTML report will work

1: PhotoName: select or show the highlighted picture.

2: PhotoCaption: use this field to describe the picture with
caption text (30 char max).
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Go to the PhotoName field and press OK. You can select
from the following options:

e SEL: Select the highlighted photo.
e SHOW: Show the highlighted photo.
¢ REMOV: Remove the selected photo.
1. Select a JPEG file from the current default
directory using the A and V keys.
2. Press SHOW to review the photo.
3. Press SEL to select the photo.

4, Press OK to confirm the choice of the selected file
and return to the previous directory.

5. Press REMOV to remove the selected file.

NOTE: An error message will appear if the photo
is unsuitable.

7.4.7 Site page

The site page allows you to enter information about the
site or location that you are surveying. This page is useful
when your client’s office address differs from the survey
location, for example when your client is a real estate
agent and the survey site is located at a letting property.

This information appears on the Report Details page.

1: SiteContact: name of the principal contact for the site
(80 char max).

2: SitePosition: contact’s position; you could enter landlord
or receptionist for example (30 char max).

3: SiteAddress: address of the site under survey
(50 char max).

4: SiteTel: landline telephone number of the site
contact (20 char max).

5: SiteMob: mobile or cellular phone number of the site
contact (20 char max).

6: SiteEmail: email of the site’s contact (30 char max).

7.4.8 Survey

The survey page allows you to enter information about
the survey you conduct.

Survey information appears on the Report Details page.

56 P350 flexitrax Operation Manual

1. Date: Date the survey took place (10 char max).

2: Surveyor: Surveyor’s personal or company name
(80 char max).

3: Log: Log number (30 char max).
4: Qur Reference: Your reference number (30 char max).

5: Client’s Reference: Customer reference number
(30 char max).

6: Operator: Survey operator (30 char max).
7: Start: Survey starting point (7 char max).
8: Finish: Survey finishing point (7 char max).

9: Direction: Survey direction; choose between upstream
or downstream using the and keys.

10: Survey Length: Length surveyed (30 char max).
11: Height: Manhole depth (30 char max).

12: Material: Pipe material (30 char max).

13: Size: Pipe size (30 char max).

14: Shape: Pipe shape (30 char max).

15: Water Level (30 char max).

7.5 Editing reports

You can edit reports at any time using the P350
command module.

NOTE: You can also edit reports in Microsoft Word.
See Section 7.8 for more information.

1. Press .

2. You can now edit pages and fields as described
in Section 7.4.

1. Enter the CARD menu.

2. Usethe A and v keys to select the folder
containing the report you wish to edit.

3. Press REPOR.

4. If more than one, select the report you wish to
edit using the A and V arrows.

5. Press EDIT to edit the selected report.



6. You can now edit pages and fields as described
in Section 7.4.

7. Press CLOSE to close the report.

7.6 Deleting reports

You can delete reports at any time using the P350
command module.

Press .

Press CLOSE to close the report
Press =l and enter the REPOR menu.

—

A

If you have more than one report in the default
working folder use A and V to select the one
you wish to edit

5. Press DEL.

6. Press YES to confirm or NO to abort the operation.

1. Enter the CARD menu.

2. Usethe A and V keys to select the folder
containing the report you wish to delete.

3. Press REPOR.

4. If more than one, select the report you wish to
edit using the A and V arrows.

5. Press DEL to delete the selected report.

6. Press YES to confirm or NO to abort the operation.

7.7 Viewing and printing reports

You can view reports on your desktop or laptop
computer. Generated reports can be viewed on a
computer running Microsoft Windows XP or Vista and
Internet Explorer 6 or later.

7.7.1 Folder structure

The report is generated as a series of HTML documents
organized into a number of subfolders contained in the
main report folder. The principle is similar to that of an
internet website. By default, the report folder is stored in
the current default working folder of the Compact Flash
card and is hamed according to the name you gave the
report when you created it.

For example, 30NOV/MYReport

Reports are organized as follows:

¢ [MyReport]: top level report folder, named according
to your preference when you created the report.

e [data]: folder containing the XML data files.

¢ [images] folder containing the images you attach to
the report.

¢ [pages]: folder contains individual HTML pages.

® |ogo.jpg is your company or business logo. This is
the logo entered in the COMPANY. You can replace
this file as required.

e report.html is the main page of the report.

NOTE: Please take care to copy or move the entire
report folder (including all sub-folders) to your computer
when retrieving the report from the Compact Flash
card. The report folder contains multiple sub-directories
that are required for viewing and converting the report.

A

7.7.2 Browsing and printing

Figure 7.5: Viewing reports in Internet Explorer
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1. Connect the command module to your computer
using the supplied USB cable.

2. Once your computer recognizes the command
module, use Windows Explorer to locate the
report folder.

3. You can then copy or move the report folder
to your computer or view it directly from the
Compact Flash card.

4. Using Windows Explorer locate the report.html file
in the report folder.
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5. Open “report.ntml” with Internet Explorer.

6. If prompted, allow Active Content by right-clicking
the yellow warning bar and select the ‘Allow
Active Content’ option.

7. The report will load and display the navigation
frame on the left and the title page on the right.

To assist navigation, the report is presented in a similar
fashion to a web site or a PDF document with bookmarks
(Figure 7.5).

The report is divided into two frames:

¢ The navigation frame (Figure 7.6) on the left displays
a link to each page and a print link that prints the
currently displayed page.

® The content frame on the right displays the currently
selected report page.

To print a page, select it using the links on the navigation
frame and then press the Print This Page link. You must
repeat this step for each page of the report.

Figure 7.6: Report Navigation

1 Title Page

2 Beport Details
3 Ohservations

4 Photos Small

5 Photos Large
& Comments

Prnt Thiz Page

Eadiodetection Ltd.
Radipdetection

NOTE: Use the Print This Page link rather than using
the File -> Print command, otherwise the printed page
will also include the navigation frame and be printed in
landscape format.

7.8 Exporting reports to Word

FlexiSight is a Windows-based application bundled with
the P350 flexitrax system that allows you edit video and
convert reports to Microsoft Word format. This section
provides help on using the report conversion function. For
instructions on how to use FlexiSight to edit your videos,
please consult the FlexiSight help.

You can use FlexiSight to convert the inspection report
to a single Microsoft Word document. Once converted to
Word format, you can edit the report as you wish.

58 P350 flexitrax Operation Manual

NOTE: FlexiSight does not overwrite the original report
data so if you accidentally delete your text you can re-

import the original HTML report and create a new Word
document.

Once you convert the report to a Word document, you
can save the report to any file format your word processor
supports.

7.8.1 Conversion requirements

To convert an inspection report to Microsoft Word format,
you need the following system requirements.

e Microsoft Windows XP with Service Pack 2 or 3.
¢ Microsoft Office 97 or later.

¢ FlexiSight 2 or later.

7.8.2 Conversion overview

FlexiSight will convert the HTML report to a single
document. By default a report has 6 sections, which are
detailed as follows:

¢ Title page: title and date of report.

¢ Report details: includes Survey, Company, Client
and Site details.

e QObservations: details the observations you made
while in situ and includes thumbnail images.

¢ Photos Small: shows captioned photos in a small size.

¢ Photos Large: shows captioned photos in a large
size.

e Comments: free form text comments.

Once the conversion is complete, you can edit and
modify any part of the report. This is particularly useful

if you need to expand or include new comments and
observations or correct any spelling mistakes. You can
also change typefaces or styles to reflect your company’s
house style and position graphics and logos accordingly.

NOTE: Close all open Microsoft Word documents
before you begin the conversion process.

1. Connect the command module to your computer
using the supplied USB cable. See Section 6.7.

2. Navigate to the folder where you report is located
and copy the folder to your computer.

3. Open FlexiSight.
4. Click Report on the menu bar.

5. Use the file browser (Figure 7.7) to select the
report folder and click OK.



6. FlexiSight will open Word and initiate the
conversion. When the process is complete the
document will be available in Word.

Figure 7.7: FlexiSight Report select box

H
ESEN
Z3DVC
S 07Apr

[1data
[limages
[ pages

= ;I

7.8.3 Conversion troubleshooting

FlexiSight will not open a folder that contains missing or
damaged report data files. Make sure that you copy the
whole report folder to your computer before attempting to
convert the report.

Do not manually edit report XML data files as this may
render the report unreadable to FlexiSight. If you need to
amend your report, do so using the command module’s
report editing feature or edit the converted report using
Microsoft Word.

7.8.4 Customizing the Word template

FlexiSight uses a standard Word document template to
create Word versions of inspection reports. If required,
you can modify this template to change the design of the
converted report to suit your company’s house style.

The template is located in the FlexiSight installation
directory, which by default is located in the Program Files
directory on your computer. You can edit this template in
Word and resave the document as a .DOT file.

Before attempting to edit this document, it is
recommended that you back up the original file.

If you choose to edit the template, make sure you do
not edit or delete any of the data codes stored in the
document. FlexiSight uses these codes to properly
embed report data into the generated document.
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Section 8 - Digital Video

The P350 flexitrax incorporates an advanced digital
video recorder. This section provides an overview
of the P350 flexitrax digital video recording and
playback capabilities. Also included is a detailed
section on converting video files to other popular
formats for playback and distribution.

8.1 Video Specification

The P350 flexitrax system produces high-quality digital
video files encoded with H.264 video and AAC audio
CODECGCs. The resulting files have an MP4 extension.

8.2 Video quality Settings

The P350 flexitrax can record video using several
predefined quality settings. The system also allows you to
configure video quality settings to suit your requirements.

The P350 flexitrax includes three predefined video quality
settings. Video quality is set using the DVR Record
Settings menu. The High quality setting provides high
quality recordings but produces larger file sizes, which
reduces the number of recordable hours per gigabyte.
The medium and low quality settings produce smaller file
sizes and provide more recording hours per gigabyte.

1. Enter the DVR menu.

2. Select QUAL and then choose High, Medium or
Low quality video as required (Figure 8.1).

The table below provides an overview of the predefined
video quality settings.

Table 8.1: Video Quality profiles

Figure 8.1: DVR Record settings menu

Recording quality:
HIGH MED LOW ADY

High

Figure 8.2: Advanced video settings menu

Frame
Bitraote:

Encoding:

Maximum

Frame raote

Property Video Quality Profiles

High quality Medium quality Low quality Custom
Frame size VGA VGA QVGA user defined
Bitrate High Medium Low user defined
Encoding Progressive half Progressive half Progressive half user defined
Framerate Maximum (full) Maximum (full) Maximum (full) user defined
Recording Time hrs* | 1:45 3:45* 9:00* varies

*Approximate recording time based on 2GB Compact Flash Card
** Recordings exceeding 2 hours in length are split into multiple files
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8.2.1 Custom quality settings

In most circumstances, the predefined quality profiles

are sufficient. However, you can define your own quality
settings to suit your recording requirements. To adjust
the video quality settings select the ADV option under the
DVR quality menu (Figure 8.1).

The Advanced Recording menu (Figure 8.2) allows you
to set the Frame Size, Bitrate, Encoding and the Frame
Rate.

The frame size (SIZE) menu allows you to select the
dimensions (in pixels) of the recorded video. Your options
are:

e Full: PAL (720x576 pixels) or NTSC (720x480 pixels)
depending on your camera.

e VGA: 640x480 pixels.
e QVGA: Quarter VGA, 352x288 pixels.
1. Use /\ and \/ to select your choice.

2. Press OK to confirm or <J to return to the
settings menu.

Bitrate (BRATE) sets the bitrate (memory usage in
megabits (Mb) per second of recording). Select between
High, Medium and Low.

1. Use /\ and \/ to select your choice.

2. Press OK to confirm or < to return to the
settings menu.

Encoding (ENC) sets the encoding. Select between
Progressive Full, Progressive Half or Interlaced.

1. Use /\ and \/ to select your choice.

2. Press OK to confirm or < to return to the
settings menu.

NOTE: Selecting interlaced will create better quality
video but it will not play on a PC unless a suitable
CODEC is installed. FlexiSight supports only
progressive encoding.

The frame rate (FRATE) option sets the amount of frames
per second. Select between:

e Maximum (30FPS for NTSC and 25FPS for PAL).
e Medium (20FPS).
e Minimum (10FPS).

1. Use /\ and \/ to select your choice.

2. Press OK to confirm or <{ to return to the
settings menu.

NOTE: Bitrate is the only parameter that will affect your
recording sizes. Higher bitrates will result in better video
quality and larger file sizes.

8.3 Advanced video options

The P350 flexitrax features several advanced video
settings. You can for example, change the default
destination and file names for recorded videos. You can
also choose to include a title page on the start of each
video.

Advanced video options are available in the DVR options
menu.

8.3.1 INPUT

The input menu (DVR -> INPUT) allows you to set the
video source for display and recording.

There are 3 choices: Auto, Camera and External. The
default setting is Auto.

1. Use /\ and \/ to select your choice.

2. Press OK to confirm or <{ to return to the
settings menu.

The Auto setting gives preference to the external video
source (if present).

The Camera setting selects the P350 camera as the
default video source.

The External setting selects the external video source.

You can connect an external video source to the
command module or powered drum or manual PSU using
standard composite RCA or BNC cables as required.

The command module’s video input jack is located
inside the I/O interface panel (Item 8 in Figure 2.3) and is
highlighted with a yellow ring around the jack.

The powered drum or manual PSU’s video input jack is
located on the connection panel (Item 9 in Figure 2.7)
and identified by the text: VIDEO IN. If the selected video
source is not present the P350 Command Module will
show a Color Bar display. Check your settings and/or
connections to the video source if this happens.

A
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8.3.2 DESTN

The destination menu (DVR -> DESTN) allows you to set
the destination folder on the Compact Flash card for new
video recordings, pictures and reports.

Use this command to organize, if you wish, your survey’s
data in different folders: one for each job for example.

See Section 6.3.1 for more information on organizing your
work.

NOTE: At startup the system will default to a directory
based on today’s date. For example: 01Jan for the first
of January

1. You can create a new folder by selecting NEW.
2. Type the new folder name and press OK.

3. Press CANCL to abort.

1. Use /\ and \/ to select the folder you wish to use.

2. Press SET to use the selected folder as default
working folder.

1. Use /\ and \/ to select the folder you wish to
rename.

2. Press RENAM.
3. Type the new folder name and press OK.
4. Press CANCL to abort.

NOTE: The command module will display an error
message if the folder name already exists.

8.3.3 FNAME

The File Name menu (DVR -> FNAME) allows you to
append a prefix to new video or picture files.

Use this command to personalize your video recordings
and still pictures.

To create a file name prefix, enter the FNAME menu and
type the prefix, limited to 7 characters.

New files will have the following structure:
¢ prefixddmmmxxx.ext.

For example, CREW1_30NOV001.MP4 where CREW1_
is the prefix and 3ONOV001.MP4 is the timestamp and
extension included by default (see Section 6.3.2).
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8.4 Video playback

You can play recorded video using the command module
or any computer system that has compatible video
playback software and CODECs installed.

8.4.1 Command module playback

Video playback using the command module is described
in Section 6.6.

8.4.2 Computer playback

Videos can be transferred and played on any compatible
computer that features the following:

e Correctly installed video and audio CODECs and a
compatible video player program.

or

¢ A compatible video player program with integrated
H.264 and AAC CODECs.

VLC (from the Videolan project) or Quicktime (from Apple)
support files created with the P350 command module.
Both VLC and Quicktime do not require additional
CODEGCs and are available free for Microsoft Windows XP,
Windows Vista, Mac OS X and most Linux distributions
(VLC only).

VLC media player is available on line from the VideolLan
project website.

Quicktime media player is available on line from the Apple
website.

NOTE: VLC contains the libdvdcss software library,
which may be prohibited for use in your country. Note
however that libdvdcss is not required to play videos
recorded by the P350 flexitrax. Please seek appropriate
legal advice before downloading and using VLC.

By default, Microsoft Windows Media Player cannot
play the MP4 video files created by the P350 system
as it requires additional video and audio CODECs to
be installed.

You can install the correct CODECs for playback on
Microsoft Windows XP or Vista by installing FlexiSight.
Once installed, you can play the files using Windows
Media Player.

A



Your computer may already have third party H264

and AAC CODEGQ:s installed. While these may enable
playback using Windows Media Player (or other playback
software) they may inadvertently affect the performance of
FlexiSight and your computer.

This is known as CODEC conflict. CODEC conflict may
cause your video program or your entire system to
become unstable or even crash. If you suspect a CODEC
conflict has occurred, uninstall FlexiSight and all third
party H.264 and AAC CODECs then reinstall FlexiSight.

CODEC conflicts can be troubleshot using a number
of online free tools. Tools like GSPOT or Sherlock: The
Codec Detective will allow you to see which CODECs
you have installed on your PC and if they can play MP4
(H264/AAC) files.

Alternatively use a dedicated videoplayer that supports
H264/AAC files.

Figure 8.3: Video playback on Windows XP using VLC media player
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8.5 Distributing your recordings

When it comes to distributing your recordings the first
thing to consider is your customer’s requirements.

Generally speaking there are two possibilities: they may
require a DVD or a digital video file.

e DVDs are one of the most popular ways to distribute
videos. Domestic DVD players are found in most
households and modern PCs are equipped with a
DVD player.

e Digital video files are quickly becoming very popular
as they can be easily edited and digitally stored on
company servers. More advanced DVD players can
also play some video files. Digital video files can be
distributed on CDs, DVDs, flash memory or even
electronically via the internet.

Once you decide on the distribution media you must
know if they will play their video (DVD or digital file) on a
television or a PC.

Most televisions, even modern LCDs, and standalone
DVD players and recorders are designed for standard
broadcasting. As such they may be unable to display

or record the video produced by the P350 command
module correctly. This is because the P350 makes use of
the entire 4:3 video picture available, whereas standard
broadcasts usually do not.

NOTE: 4:3 refers to the standard aspect ratio of PAL
and NTSC broadcasts priors to the advent of standard
and high definition widescreen broadcasts.

Depending on the implementation of overscan (the
ability to display the entire 4:3 picture space), different
TVs and DVD players will show different video sizes
varying between the full 4:3 picture and the broadcasting
Graphics safe areas.

The 4:3 Action Safe area is defined to be between 3.3%
and 3.5% smaller than the 4:3 full video size. The 4:3
Graphics Safe area is defined to be between 5% and
6.7% smaller than the 4:3 full video size. This is illustrated
in Figure 8.4.

Figure 8.4: 4:3 aspect ratio video space usage

4:3 VIDEO

4:3 SAFE AREA - ACTION

4:3 SAFE AREA - GRAPHICS

The P350 Command Module offers a number of different
OSD and text layouts that will optimize your video
recordings and analog video output signals to suit your
desired target audience.
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To produce a DVD or digital video file recording to be
played on a TV screen set your OSD layout to TV layout.

To produce a DVD or digital video file recording to be
played on a PC screen set you OSD layout to Normal
layout.

See Section 4.5.2 for more information on how to set
OSD layouts.

8.5.1 Producing a DVD video

The quickest ways to produce a DVD disc from a P350
recording are:

e using a DVD recorder
or
e using a PC or Mac computer.

If you have a domestic DVD recorder with composite
video inputs, you can copy the video direct to a blank
DVD using the following procedure:

1. Ensure you have recorded your survey with the
OSD set to TV layout.

2. Connect any of the P350 flexitrax video outputs to
your DVD recorder’s video input sockets using a
suitable composite video cable.

3. Switch on the command module and locate the
file you wish to convert using the file browser.
Do not play the file at this stage.

4. Insert a blank DVD into the DVD recorder and
begin recording.

5. Play the file on the command module.

Note: if your recordings were not set to TV mode use
the digital zoom function on the command module to
match the P350 video picture size to the one captured
by your DVD recorder and displayed by your TV.

6. When the file is finished playing, stop the DVD
writer and, if required, finalize the DVD disc
following the DVD recorder’s user documentation.
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To produce a video DVD using a PC or Mac you will
need a computer equipped with a DVD burner and a
compatible authoring program.

Nero 8 or later and Xilisoft's DVD Creator supports H264/
AAC recordings for Windows based PCs. Roxio Toast is
available for Mac Users.

These programs feature easy-to-use wizards that guide
you through the conversion and burning process.

To produce your DVD just select the MP4 recording that
you want to convert and select the DVD Video creation
function.

NOTE: You will have to set the OSD layout to TV before
recording your survey in order to ensure that resulting
DVD will play on a TV.

8.5.2 Supported digital video files

The flexitrax system creates MP4 files which are encoded
in H.264 for the video and AAC for the audio.

If you decide to distribute MP4 files created with the
flexitrax system you must ensure that your customer is able
to play the files on his computer. To do this your customer
must have the right CODECs installed or a dedicated digital
video player that supports both CODECs.

Alternatively you may distribute (subject to licensing) a
suitable third-party media player or the relevant CODECS
with your recordings.

See Section 8.4.2 for more information on playing back
ona PC.

Your customer may require a different file format. The
most commonly used is an AVI file encoded in MP42 for
the video and WMA2 for the audio. AVI files encoded in
this way are usually supported by Windows without the
need of any additional CODECs.

You can create such a file by using FlexiSight, if installed
on a PC running Windows XP. Just open the original
MP4 file and save it as an AVI file by selecting the file type
required in the “save as” dialog box.

Please note that FlexiSight will re-encode the original
video. The operation will take some time and the resulting
video quality will be inferior to the original file. The length
of the final file may also be much larger depending on the
complexity of the video.



8.5.3 Unsupported digital video files
A\

In order to produce a different video digital file you will
have to use a video conversion application to re-encode
your file.

Video conversion software gives considerable control over
many video properties, allowing you to create files that
best suit your requirements.

On Microsoft Windows systems, third-party applications like
the “Ultimate” video converter offered by Xilisoft (commercial)
or Super®© (free), both available on the web, can convert
P350 MP4 files into many other digital video formats.

For an introduction on converting P350 videos to different
(unsupported) formats using a computer, please refer to
Section 8.6.

A popular file format supported by many newer DVD players
and many portable digital players is DivX. You can re-encode
our files in AVI DivX by using a suitable video converter.

DivX CODECs for Windows and Mac are available to
download freely for personal use.

Xvid is an open source implementation of the DivX
CODEC. Most Xvid encoded files will play on a DivX
certified player.

The advantages of this format are:
e (Good quality at reduced file size.

¢ Wide playability with digital media players and some
domestic DVD players.

e Does not require a DVD or CD burner to produce.
The disadvantages of this format are:

e Encoding process can take longer than other
formats.

e Requires a suitable CODEC or a compatible media
player to play on computers.

The QuickTime format is based on a similar H.264
CODEC as the native P350 video format, thus it enjoys
the same quality to file size ratio. The QuickTime format
is playable on PC and Mac computers using Apple’s
QuickTime media player.

The advantages of this format are:
¢ Good file size to quality ratio.
e Preferred video file format for Apple Mac computers.

¢ Playable on Apple’s ubiquitous personal media
players and smartphones.

¢ |s suitable for embedding in web pages for
distribution on the internet.

¢ Does not require a DVD or CD burner to produce.
The disadvantages of this format are:

e Encoding process can take up to three times longer
than other formats.

¢ Requires QuickTime or the VLC media player for
playback on a computer.

¢ |s not playable on domestic DVD players.

8.5.4 Using data CDs, DVDs and USB
flash drives

You can copy any digital video file on to a standard,
blank data DVD or CD using any burning program that is
compatible with your computer.

NOTE: If using an Apple Mac, be sure that you encode
your DVD using the Joliet file system for maximum
compatibility with Windows-based computers.
Windows cannot read DVDs encoded with the native
Mac HFS file system.

Alternatively you can distribute your video files using

a standard USB memory stick. These devices are
inexpensive and can offer storage capacities greater than
DVDs. These devices are simple to use and do not require
the use of a DVD or CD burner only a free USB port on
your computer.

NOTE: For maximum compatibility between computers
and other devices, ensure your USB memory stick is
encoded using the FAT32 file system. Individual files
stored on FAT32 formatted drives must not exceed 4GB
in size; the total of all file sizes may be greater than 4GB.
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8.6 Converting digital videos
A\

Digital conversion requires the use of a computer to
convert the video files from their native format to another
digital file format.

Using this method you can convert video files to almost
any format you require, for example:

e DivX / Xvid.

VCD / MPEG1

QuickTime.

Flash Video (FLV).

Windows Media Video (WMV).

8.6.1 System requirements

Below is a list of recommended minimum specifications
for converting and editing digital video files on Windows
and Apple Mac computers.

¢ \Windows XP or Windows Vista.

e An Intel Pentium 4 or AMD Athlon 64 processor or
higher.

e 512MB of RAM (1GB if using Vista).

e CD or DVD burner (for producing DVDs, VCDs or
distributing video files on optical media).

¢ \/ideo conversion software.

e Mac OS X 10.4 or later.
e Any G5 or Intel processor.
e 512MB of RAM (1GB if using 10.5).

e CD or DVD burner (for producing DVDs, VCDs or
distributing video files on optical media).

¢ \/ideo conversion software.
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8.6.2 Conversion software for Windows

The Ultimate Video Converter is a commercial utility
that can convert video files using internal CODECs. The
Ultimate Video Converter is available for purchase for
Windows and Mac computers from the xilisoft web site.
The Ultimate Video Converter can convert P350 video
recordings into the following formats:

e MPEG-1. e DivX/ Xvid.

e MPEG-2. o WMV

e MPEG-4. ¢ Flash Video.

e VCD. e QuickTime.

e SVCD. e DV (see Section 8.7.2).
e DVD.

Super © is a freeware utility for Microsoft Windows XP
and Vista that can convert video files using internally
bundled CODECs. Super © is available for download from
the erightsoft website. Super © can convert P350 video
recordings into the following formats:

e MPEG-1. e DivX/ Xvid.

e MPEG-2. e WMV.

o MPEG-4. * Flash Video.

e VCD. e QuickTime.

e SVCD. e DV (see Section 8.7.2).
e DVD.

8.6.3 Conversion software for Mac OS X

ffmpegX is a freeware utility that utilizes the open-source
video libraries embedded in Mac OS X. ffmpegX is
available for download from the ffmpegx website. ffmpegX
can convert P350 video recordings into the following
formats:

e MPEG-1. e DVD.

e MPEG-2. e DivX/ Xvid.

e MPEG-4. e QuickTime.

e VCD. ¢ Flash Video.

e SVCD. e DV (see Section 8.7.2).



To convert P350 video using ffmpegX, please consult the
application’s online help which is available on the ffmpegX
website.

8.7 Advanced video editing

8.7.1 FlexiSight

FlexiSight is a Pearpoint PC application that can perform
basic editing on P350 video files. This program is
compatible with Windows XP and Vista only.

FlexiSight allows basic editing only. With FlexiSight you
can take and annotate snapshots, delete footage and

merge clips. For more information on using FlexiSight,

please refer to the FlexiSight online help.

NOTE: The CODEC:s installed by FlexiSight do not
support MP4 videos encoded with interlacing.

8.7.2 DV

DV, or raw digital video format, is an uncompressed video
file format that is commonly used in consumer digital
camcorders and professional recording equipment.

The advantages of this format are:
e Cross-platform format.
e \ery easy to edit, cut and composite video.

e Can be converted to almost any distribution format
such as DVD or DivX.

The disadvantages of this format are:
* File sizes are very large.
¢ Not suited for distribution.

e Editing software can be expensive and difficult
to learn.

You can convert to DV format in two ways: analog or
digital. To make an analog conversion you need video
recording equipment with analog video inputs that has the
ability to record to DV.

To make a digital conversion you need to copy your video
files to you computer and use conversion software to
create a DV version of your video file. Both Super C and
ffmpegX can convert P350 video files to DV format.

NOTE: DV video files are up to 10 times the size of
compressed video formats. Ensure you have sufficient
hard-drive space before you attempt to convert to DV
format.

The DV format is widely supported on many consumer
and professional non-linear digital video editing software.
Below is a list of programs that support the editing of DV
files:

¢ Apple iMovie HD 6 and iMovie 08 (Bundled with the
iLife suite).

¢ Apple Final Cut Express and Final Cut Pro.

¢ Adobe Premiere Elements and Adobe Premiere Pro.
¢ Windows Movie Maker (Free with Windows XP).

¢ Windows DVD Maker (Free with Windows Vista).

NOTE: Editing DV files in non-linear editing programs
is a complex process that is beyond the scope of

this manual. The programs listed above are well
documented and feature introductory tutorials. Please
refer to these before you attempt to edit your video.
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Section 9 - Appendix

9.1 Shortcuts

This appendix includes a list of keypad and keyboard
shortcuts featured on the command module. Familiarizing
yourself with the shortcuts will allow you to work more

efficiently.

You can access a list of available shortcuts by pressing
Fn + F2 on the keypad or SHIFT + F2 on the keyboard.

Table 9.1: Miscellaneous commands and shortcuts

Keypad key
Fn+ | F1
Fn+ | F2
Fn+ | F4
Fn+ | F5
Fn+ | F6

Table 9.2: Crawler commands and shortcuts

AV

Keyboard key
Shift + | F1
Shift + | F2
Shift+ | F4
Shift+ | F5
Shift + | F6
Fo
F10
H
P
Ctl+ | 7T
Ctrl+ | 4

Keypad key | Keyboard key

A

V
<

>

)

T
\

e

Ctrl+ | C
Alt + <«

Alt + -
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Description
Help
List all shortcuts

Software versions
screen

Sonde on/off

Jump to top menu
(when possible)

Enter counter value

Callibrate / zero
counter

Switch Mimic
on/ off

Start / stop
Pitch Profiler

Decrease drum
rate of pull
(manual mode only)

Increase drum rate
of pull (manual
mode only)

Description
Drive forward
Drive backward

Steer left
(P356 crawler only)

Steer right
(P356 crawler only)

Motion Stop
Lock steer left

Lock steer right

Ctrl +
Ctrl +

Table 9.3: Camera commands and shortcuts

%
M

Space-
bar

Keypad key | Keyboard key

Ctrl +
Ctrl +
Ctrl +
Ctrl +
Ctrl +
Ctrl +
Ctrl +
Ctrl +
Ctrl +
Ctrl +
Ctrl +

Ctrl +
Ctrl +
Ctrl +

olz m X &

v o X >»=s </ c A

Trim left
Trim right

Switch drive mode
(MAN / AUTO)

Motion Stop
(Drive mode only)

Description
Light —

Light +

Iris close
Light switch
Pan reset
Pan right
Pan left
Rotate clockwise
Zoom reset
Zoom out
Zoom in

Iris open

Rotate
anti-clockwise

Focus in
Rotate reset
Focus out
Target UP
Target Left
Target Down
Target Right
Go to Target

PT camera Scan
pipe joint



Table 9.4: Video commands and shortcuts

Keypad Key | Keyboard key | Description
Ctrl+ | A Play
Ctl+ | Q Take snapshot
Ctrl+ | S Pause
Ctrl+ | W Text
Ctrl+ | X Video stop
Cirl+ | Z Record

9.2 Care and maintenance

WARNING! Clean and sanitize the P350 flexitrax
system with a suitable disinfectant at regular intervals
to help prevent the risk of biological contaminations
from foul water sources. Use appropriate gloves when
cleaning the system.

Do not dismantle component parts, unless directed by
this manual.

9.2.1 Terminals

A

Ensure that all terminals and connection points are clean
and free of corrosion and debris before you attempt to
use this equipment.

Check that any O-rings are clean, greased and not
damaged. Use a silicon based grease such as "Super Lube".

Pearpoint recommends protecting all terminals with
plastic protection caps when the system is not in use.

If possible, only assemble or disassemble system
components in a dry and clean environment.

9.2.2 Cleaning the system

WARNING! Foul water systems can be a source
of biological hazards; ensure you clean all equipment
with a suitable disinfectant after use.

e (Clean the case with mild soapy water.
e Use lint-free cloth to clean the LCD screen.

e (Clean with water and disinfectant.
e (Clean the lens with a lint-free cloth.

e Use a cloth moistened with disinfectant.

9.2.3 Storing the system

The P350 flexitrax is a precision system. Always store the
system, including all components and accessories, in a
clean and dry environment.

9.3 Upgrading software

Pearpoint may issue P350 system software updates

to enhance performance and improve stability for any
component of the system. To find out if Pearpoint has
released a new software update, please visit
www.radiodetection.com or contact your local
Pearpoint representative. It is highly recommended that
you periodically check for new software releases and
update your system when software is made available.

Software downloads are free of charge.

The P350 system’s integrated software is made up

of several individual software files needed by each
individual component to work and communicate correctly.
Pearpoint releases all software in a zipped bundle. The
zip file also includes a readme file that details the current
version number for each software file.

NOTE: Your system may already have the latest
software installed. Check your system’s software
versions against the version log in the readme file
before you attempt to upgrade your system.

Press Fn + F4 to access the Software Versions info
screen, see Figure 9.1. This screen displays all the
software versions.

NOTE: The P350 Command Module, Drum and Crawler
need to run compatible software versions, otherwise
the system may not work correctly. If the software
loaded on a component is incompatible with the rest

of the system or missing, as a result of a failed upload,
this is reported on the info pages When a software
mismatch or missing application on a component is
reported, you need to complete a software upgrade on
that component.
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Figure 9.1: Software Versions info page

versions @

Software

e controller.bin
e interface.bin

e tractor.bin

e drum.bin

e ptcamera.bin
e ptzcamera.bin

When new software is released, it is highly recommended
that you upgrade every component to the latest software
otherwise malfunctions may occur during operation.

To update your system, you must first download the
software bundle containing the latest P350 software from
www.radiodetection.com.

Once you download the software bundle to your
computer, extract them using WinZip or a similar archive
package manager and copy the extracted files to the root
directory of a Compact Flash card.

If you intend to use a Compact Flash card that contains
survey files, be sure to back up the data on to your
computer before continuing.

Insert the Compact Flash card into the command module
and switch the system on.

NOTE: The system should be completely assembled
if attempting to upload new crawler software. Please
check the presence of the drum and crawler status
indicators before attempting to update them.
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NOTE: Upgrading components with the latest software

may take several minutes. If the upgrade is successful,

the command module may prompt you to reboot. Press
OK to reboot the system.

NOTE: If you receive any error messages, check that
you have copied all .BIN files to the root of the card and
then try again.

To check the camera’s software version, see Figure 9.2:
SETUP->DEVCE ->CAM->INFO

To upgrade the camera’s software:
SETUP->DEVCE->CAM->ULOAD

Figure 9.2: Camera info page
< Camera

Camera: FW

Software:

To check crawler’s software version, see Figure 9.3:
SETUP -> DEVCE -> TRACT -> INFO

To upgrade the crawler’s software:

SETUP -> DEVCE -> TRACT -> ULOAD



Figure 9.3: Crawler info page

sogftware:

AUX:

none
Wheel diometer:

Active: T35

hours

To check the powered drum and manual PSU’s software
version, see Figure 9.4:

SETUP -> DEVCE -> REEL -> DRUM -> INFO
To upgrade the drum and manual PSU'’s software:
SETUP -> DEVCE -> REEL -> DRUM -> ULOAD

Figure 9.4: Drum info page

Drum @

Auteo-stop

To check the command module’s software version, see
Figure 9.5:

SETUP -> DEVCE -> CONTR -> UPDTE -> INFO

To upgrade the command module’s main software:
SETUP -> DEVCE -> CONTR -> UPDTE -> MAIN

To upgrade the command module’s interface software:

SETUP -> DEVCE -> CONTR -> UPDTE -> IFACE

Figure 9.5: Command module info page

code 55

Interface:
FPGA
Miecro

If a software upgrade has been sucessfule the system
will display a message saying “Upload OK”. Press OK
to continue.

If a software upgrade has failed a message will be
displayed indicating the error. If this happens perform
the upgrade again.

9.4 Crawler cable re-termination

You must re-terminate the cable if you suspect that video,
power or communication signals are in anyway degraded.
This may be indicated by poor video quality, intermittent
power shortages or an unresponsive crawler.

The P350 flexitrax crawler cable re-termination guide
is available to download from the download section of the
Radiodetection website: www.radiodetection.com.

This guide provides a detailed, step by step,guide on how
to re-terminate the crawler cable.

The cable re-termination procedure should only be
performed by skilled and adequately trained technicians.
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Figure 9.6: Drum cassette replacement (exploded)

1 Slave side exterior panel
2 Drum cassette support channel
3 Cassette hub

4 Cable cassette
5 Drum hub

9.5 Cable drum replacement

In the powered drum, the cable is housed in a cassette.
This component is user-replaceable. The following
procedure outlines the removal and replacement of the
cable cassette.

A WARNING! Switch the system off and disconnect
the power lead and all other cables before you
continue.

9.5.1 Disassembly

1.
2.

Remove the slave-side panel, see Figure 9.6.

Remove the drum cassette support channel, see
Figure 9.7.

The drum cassette is held in place by the cassette
hub. Do not remove this hub yet; proceed to the
next step.

Remove the cable from the cable layering
mechanism. To do so:

Lift the spring loaded pinch roller to the
upright position, see Figure 9.10.

Unfasten the cable retaining rollers. The rollers
are held in place by thumb screws on the
reverse side of the cable layering mechanism.
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Finally remove the top horizontal exterior cable
guide (Figure 9.7).

Remove the cassette hub.

Disconnect the internal cassette cable connector
from the drum hub.

You can now remove the cassette from the
drum hub

Figure 9.7: Powered drum with slave side panel and drum support
channel removed

Top horizontal
cable guide




9.5.2 Assembly

1.
2.

6.

Replace the drum cassette as required.

Re-connect internal cassette connector to the
drum hub (Figure 9.6).

Secure the cassette hub.
Re-fit the drum cassette support channel.

Thread terminated cable through layering
mechanism ensuring both cable retaining rollers
(Figure 9.9) are returned to their ‘locked’ position
and that the spring loaded pinch roller is in it’s
down position.

Re-fit top horizontal cable guide (Figure 9.7).

NOTE: Special care is required when threading the
cable from the cable layering mechanism. You must
correctly align the cable mechanism to match the
cable’s position on the drum otherwise the cable may
become entangled. Proceed as described below.

The cable layering mechanism (Level Wind) features a
leadscrew that allows the layering mechanism to move in
two directions. When you retrieve the cable, this must be
in-line with the follower (see Figure 9.9).

To synchronize the follower to the drive train and the
cable, you may have to adjust the follower’s position
manually. To do so:

1.

Slacken the 2-off internal M6x10 screws and
move the chain tensioning block downwards
(Figure 9.8).

Remove the level wind chain drive.

Adjust position of follower by turning the sprocket
located on the end of the leadscrew to ensure the
follower is in-line with the cable exiting the drum
cassette (Figure 9.9).

Re-fit the level wind chain drive. Manually pull

the cable from the drum and ensure that the
follower moves in the correct direction when the
cable is spooling off the drum cassette. If this is
not the case, remove the level wind chain again
and manually rotate the level wind sprocket
(maintaining the same direction) until the follower
has gone right to the end of its travel and returned
to the original position.

Re-attach the level wind chain drive, move the

chain tensioning block upwards ensuring both

chains are in tension prior to fully tightening the
2-off M6x10 screws.

Replace both the drive & slave side panels.

Figure 9.8: Adjusting the drive train

block

Level wind
sprocket o

Level wind
chain drive

Sprocket
Drive side
Leadscrew
—
Follower
Slave side

9.5.3 Replacing cable

You can replace the cable in the cassette if required.
To do so (see Figure 9.11):

1.
2.
3.

Disconnect the power and crawler from the system.
Pull the cable slowly out by hand.

Disassemble the system and remove the cable
cassette following the guide in Section 9.5.1.

Remove the cassette’s strain relief clamp and
remove the remaining part of the cable end.

Insert new cable end into the drum; allow 500mm
slack when you re-fit the cable to the strain relief
clamp on the inside of the cassette.

Re-assemble the system using the procedure
described in Section 9.5.2 ensuring the level wind
follower (Figure 9.9) is in line with the entrance
hole into the drum cassette.

Reconnect the power cable and switch the
system on.

Use manual drive mode to wind the cable back in
to the drum.
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Figure 9.10: Cable layering mechanism

Level wind
sprocket

Thumb screw

Cable retaining
roller
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Thumb screw

Spring loaded
pinch roller

Cable retaining
roller

Strain relief
clamp

9.6 AVC Video licence

Use of the images recorded with this equipment is
permitted as supporting evidence of a professional survey
or report. This product is licensed under the AVC Patent
Portfolio License for the personal and non-commercial
use of a consumer to (i) Encode video in compliance
with the AVC standard (‘AVC Video’) and/or (ii) Decode
AVC video that was encoded by a consumer engaged
in a personal and non-commercial activity and/or was
obtained from a video provider licensed to provide AVC
video. No license is granted or shall be implied for any
other use. Additional Information may be obtained from
MPEG LA, L.L.C. See http://www.mpegla.com.

9.7 Defect codes text file

The defect codes file is a plain text file containing a list of
all defect codes and their description. This file must be
named “defect_codes.txt” and be saved in the root of
your Compact Flash card.

You can easily create or edit this file using any plain text
editor like Notepad for Windows or TextEdit for Mac OS
X. Alternatively, you can create your file in most word
processers and export the document to plain text using
the Save As or Export function depending on your word
processing package.

NOTE: By default TextEdit for Mac OS X produces rich
text files, which cannot be used as the defect code file.
To change to plain text format go to Format -> Make
Plain Text.

The structure of this file is simple:

Each row is a new entry. The defect code starts from

the first character and the description is placed after

one or more tab characters. Table 9.6 describes the
correct structure of the defect_codes.txt file. Note that
the >> symbol is a representation of the tab character for
illustration purposes only. A tab character is inserted when
you press the tab key on your computer’s keyboard.



Table 9.6: Defect_codes.txt structure

Code Tab char. Description

CL >> Crack, longitudinal at ...
o’clock

CC >> Crack, circumferential
from ... to ... o’clock

CM >> Cracks, multiple from ...
to ... o’clock

FL >> Fracture, longitudinal at

... O’clock

NOTE: The heading text is for descriptive purposes
only. Do not include this line in the text document as
P350 system will treat it like a defect code.

9.7.1 Text encoding

The “defects_codes.txt” file must be encoded in the
ANSI or ASCII standard to display on screen correctly.
Notepad for Windows automatically encode files using
the ANSI format.

Some text editors, may automatically encode files using
the unicode format. Unicode text is compatible with the
P350 system’s generated reports, however some unicode
characters may not be displayed correctly on the P350’s
screen. Should this problem occur, you can correct it by
opening the defect_code.txt file in your plain text editor
and changing the encoding to ANSI or ASCII format.

NOTE: On Mac OS X and several Linux systems, ANSI
encoding is referred to as Western (Windows Latin 1).

9.8 Specifications

9.8.1 Environmental specifications

Environmental* IP53 (Surface Equipment): IP68 to
100m/11bar (Downhole Equipment).

Temperature (Storage): -20 to 80°C (-4 to 176°F).
Temperature (Operating): -10 to 50°C (14 to 122°F).

*Unless otherwise stated.

9.8.2 Command module

Command module | P350-CMOD

Screen 200mm / 8" Industrial TFT,
SVGA

Storage High Speed Compact Flash

Recording Time (hrs)* | 1:45 (HQ) - 3:45 (MQ) -

9:00 (LQ)

Connectivity USB 2.0, Video In/Out, Audio
In/Out, Ethernet, Bluetooth®
Dimensions 300 x 360 x 200mm /
14" x 14" x 8"
Weight 5.5kg /12lbs

*Based on a 2GB Compact Flash card
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9.8.3 Cable Drums

Drums P350-DRUM-M P350-DRUM-P

Dimensions (L x W x H) Drum 445 x 270 x 570mm 633 x 412 x 740mm
17.5” x10.6” x 22.4” 24.9" x16.2” x 29.1”

Dimension (L x W x H) external 418 x 195 x 420mm Integral

Power Supply 16.5" x 7.7 x 16.5”

Weight external Power Supply 15.8kg Integral

Weight Drum 18kg to 29kg / 39.7Ibs to 64lbs 59kg to 70kg / 130Ibs to 154lbs
depending on cable length depending on cable length

Construction Powder-coated tubular steel frame Powder-coated steel chassis with
with steel and aluminum power steel and aluminum enclosure.
pack enclosure. Stainless steel Interchangeable alloy cable drum.
and aluminum manual cable Stainless steel and aluminum
management mechanism automatic cable management

mechanism
Power 110-240V 50-60Hz 1.2kVA. Generator (if used) to have inverter-type output
9.8.4 Crawlers

Crawlers P354 P356

Pipe diameter 100mm (4”) to 300mm (12”) 150mm (6”) to 600mm (24”)

Dimensions (L x W x H) 250mm (9.8”) x 82mm (3.2”) 345mm (13.6”) x 128 (5”) x 84 (3.3”)
X 69mm (2.77)

Weight 5.4kg (12lbs) 14kg (31lbs) approx.

Motors 1 x 50W 2 x 50W

Construction Brass and Stainless Steel Brass and Stainless Steel

Sonde frequency 512/640/8192/32768 Hz 512/640/8192/32768 Hz

Inclinometer accuracy +0.2° +0.2°

*Minimum specified diameter must be maintained along the whole length of the survey

9.8.5 Cameras

Cameras P350-CAM-FW P350-CAM-PT P350-CAM-PTZ
Dimensions (L x Diameter) | 62 x 68mm / 2.4” x 2.7” 134 x 68mm / 5.3” x 2.7” 158 x 90mm / 6.2” x 3.5”
Weight 600g / 1.3Ibs 1.8kg / 4.0lbs 2.9kg / 6.4lbs
Construction Stainless Steel Stainless Steel Stainless Steel

Focal Range 10mm to 10mm to 10mm (WIDE) to o
Horizontal Resolution > 460TVL > 460TVL >460 TVL

Sensitivity < 1.0 Lux < 1.0 Lux 1.0Lux @f1.8

LED luminance >120Im >210lm > 420Im
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9.8.6 Auxiliary lighthead

Auxiliary lighthead

Dimension
(L x Diameter)

Weight
Construction

LED Luminance

9.8.7 Elevators

Elevators

Weight
Construction

Pipe Range (P354)
Pipe Range (P356)

P350-LH-8

63 x 136mm / 2.5” x 5.4”

1.8kg / 4.0lbs

Stainless Steel and Aluminum

> 850Im
P350-ELV-F P350-ELV-A
(Fixed Elevator) (Adjustable Elevator)
0.4kg / 0.9Ibs 0.7kg / 1.5lbs
Stainless Steel and Stainless Steel
Aluminum
up to 300mm /12" up to 380mm / 15”
up to 380mm /15" up to 4568mm / 18”

9.8.8 Pendant Controller

Pendant Controller

P350-PENDANT

P350-ELV-LAM
(Large Manual Elevator)

4.5kg / 9.9lbs

Stainless Steel and
Aluminum

Not available

300mm to 600mm
12” to 24"

Dimension (L x Diameter) 250x 80 x 40mm/9.8" x3.1"x1.6”
Weight 0.7kg / 1.5lbs
Construction Linear Medium Density Polyethylene (LMDPE) and mild steel
IP Rating P64
9.8.9 Approvals

EN 61010-1:2001
IEC 61010-1:2001
UL 61010-1: 2004

Environmental:

e BS EN 60529 (IP53)

EN 61326-2-1: 2006 (Class A Emissions / Basic Immunity)

e BS EN 60068-2-64 BS (Vibration)
e EN 60068-2-27 (Shock)
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